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FOREWORD 

It gives me immense pleasure to join hands with the International Centre for Integrated 

Mountain Development (ICIMOD), the Pakistan Agricultural Research Council (PARC), 

the Pakistan Meteorological Department (PMD), and the International Maize and Wheat 

Improvement Centre (CIMMYT), in organizing the SAARC regional training workshop 

on Earth observation and climate data analysis for agricultural drought monitoring in South 

Asia from 29 July to 1 August 2019 in Islamabad, Pakistan. About 25 participants including 

local participants comprising scientists and extension officers affiliated to the Ministry of 

Agriculture, Ministry of Environment and National Agricultural Research System (NARS) 

of SAARC Member States are expected to participate in this training programme.  

The training programme, which aims to build the capacity of agriculture and climate 

scientists on the techniques of data development and analysis tailored for use in monitoring 

drought, will also provide a platform for exchanging experiences among participants.   

In South Asia, a large majority of people lives in rural areas and depends on agriculture, 

forestry, fisheries and livestock. These livelihood sources are highly vulnerable to climate-

induced hazards such as erratic precipitation, floods and droughts, as well as market price 

volatility. Considering the adverse impacts of drought on agricultural production and food 

security, it is critical that we prepare line agencies to understand the drought phenomenon 

better and monitor them regularly. 

This training programme is a timely and important endeavour and the resource book will 

serve as a ready reference for training participants. I hope that the skills and experiences 

shared in this training programme will help the participants’ in using Earth observation 

data and climate data analysis to develop a better understanding of droughts, and help them 

in monitoring them and develop timely and suitable agri-advisories. I thank the ICIMOD 

team, contributors and Dr. Pradyumna Raj Pandey, Senior Programme Specialist (Crops), 

for their dedicated efforts in organizing the regional training and for bringing out this 

resource book. 

 

 

Dr. S.M. Bokhtiar 

Director 

SAARC Agriculture Centre, Dhaka 

 

  



FOREWORD 

Increasing frequency and severity of climate-induced hazards – droughts –adversely affect 

agriculture, food security and livelihoods of populations across the Hindu Kush Himalayan 

region.  

To address this issue, ICIMOD has been collaborating with meteorological and agricultural 

institutions in the Hindu Kush Himalaya (HKH) to establish agricultural drought 

monitoring and outlook systems. This collaboration aims to improve their capacity in 

developing data products related to crop monitoring and enhancing the knowledge of 

national scientists on the interpretation of agro-climatic data in their respective countries.  

A considerable amount of research is being undertaken on agro-climatic monitoring and 

modelling, and large amounts of information on climate variability is being made available.  

Such information can aid farmers and decision-makers in making informed sustainable 

crop management decisions. However, use of such information by decision-makers in our 

region remains low. Provisioning of timely, and actionable scientific information in the 

form of advisory services can assist adaptation to environmental change, while limiting the 

economic damage and social disruption caused by environmental disasters.  

ICIMOD, through its Mountain Environment Regional Information System programme 

(MENRIS), contributes to effective evidence-based decision-making processes by 

governments, communities, and individuals using scientific data, Earth observation 

information and geospatial technologies in the areas of agriculture, environment, natural 

resources, and climate change. The SERVIR Hindu Kush Himalaya (SERVIR-HKH) 

Initiative of MENRIS collaborates with global institutions and government line agencies 

in ICIMOD’s regional member countries to promote the effective use of Earth observation 

in developing sustainable climate services.  This regional training, organized jointly with 

the SAARC Agriculture Centre (SAC), and the Pakistan Agricultural Research Council 

(PARC), in collaboration with the Pakistan Meteorological Department (PMD), and the 

International Maize and Wheat Improvement Centre (CIMMYT), aims to orient 

participants on using Earth observation information and climate data analysis in monitoring 

droughts.  We hope that through this training workshop, the participants will gain a better 

understanding of droughts using Earth observation products, and initiate and foster further 

trainings to promote institutional capacities in drought mitigation and preparedness. 

 

Dr. David Molden 

Director General 

ICIMOD 
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1 Drought concept and definitions 

Droughts are manifestations of climatic fluctuations associated with large-scale 

anomalies in the planetary circulation of the atmosphere. They imply the absence of, or 

weak precipitation, for an extended period over large areas. It is very difficult to identify 

and to clearly determine the onset as well as the termination point of a drought as it is a 

usually a slow-developing phenomenon. The effects of drought tend to accumulate slowly 

and persist over long periods of time. Making matters worse, droughts are typically not 

confined by topography that affects weather conditions, and may extend over large areas.  

Droughts are defined as the temporary reduction in quantity of rainfall, runoff, and 

soil moisture compared to the climatology of a region. Dry climates are prone to drought 

effects due to the soil moisture deficiency and high variability in occurrence of rainfall 

events and quantity. Because drought does not have a precise and universally accepted 

definition, it is difficult to assess its occurrence or measure its degree of severity. This 

ambiguity is further aggravated as drought implies different meanings and implications for 

different people. For example, a meteorologist, an agriculturalist, a hydroelectric power 

plant operator, and a wildlife biologist will have differing definitions of drought. 

In addition, drought can be defined conceptually as well as operationally (Wilhite & 

Glantz, 1985). Conceptual definitions are stated in relative terms (e.g., a drought is a long, 

dry period), whereas operational definitions attempt to identify the onset, severity, and 

termination of drought periods. Generally, operationally defined droughts can be used to 

analyse drought frequency, severity, and duration for a given return period. Among others, 

the main natural causes of drought are climate effects. Nonetheless, mismanagement of 

water resources, acid rain pollution, overexploitation, and many other man-made effects 

also contribute to the extent, appearance, continuity, and severity of droughts. 

Severity of droughts is a factor of high temperatures, winds, and low relative humidity. 

In many parts of the world, drought is also related to the timing of precipitation including 

principal season of occurrence, delays in the start of the rainy season, the occurrence of 

rains in relation to crop growth stages and the effectiveness of the precipitation ( i.e. rainfall 

intensity, its areal extent, and the frequency of occurrence). All these variables indicate that 

each drought event is unique in its climatic characteristics, spatial extent, and impacts. 

In many cases, drought severity is hard to define. Indeed, drought severity is 

determined by its duration, intensity and geographical extent, coupled with water demand 

from human activities and vegetation in the given region. Drought characteristics and 

extensive impacts render it more difficult to identify and quantify the drought effects on 

the society, economy and environment. To fully appreciate the significance of drought, the 

societal context in which it is defined also plays an important role. Despite a drought 

episode occurring during one or several consecutive seasons, its impacts on society can 

persist for many years thereafter. Additionally, drought impacts depend on the vulnerability 

of a particular society or population to drought at a particular time. As such, subsequent 

drought episodes of similar intensity, duration and extent, will likely result in different 

effects in different areas. The common theme in all drought episodes is the deficiency of 

precipitation, resulting in moisture stress for socio-ecological processes (e.g. agriculture). 
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While a number of natural and human factors can have important impacts, impact on water 

availability, water shortage and stress resulting from drought must however be understood 

as a relative condition and temporary condition, and not an absolute one (Figure 1.1).  

 

Figure 1.1: Drought types and associated socio-economic and environmental impacts. (Adapted 

from National Drought Mitigation Centre, University of Nebraska–Lincoln, USA). 

1.1 Classification of droughts 

Available records indicate that there are more than 150 definitions of drought in 

different disciplines and cultural contexts, and none of them are universal. Rather, the 

definition depends on the context and region, in addition to the ecological or social process 

that moisture deficit is related to, thus leading to different conclusions. Despite these 

differences, every drought events can be characterized by a deficiency in a variable related 

to the hydrological cycle. Hence, most definitions can be summarized as the lack of 

adequate water supply relative to demand or need (Quiring & Papakryiakou, 2003). To 

clarify, droughts can be classified into four categories (Figure 1.2, Wilhite & Glantz, 1985), 

along with drought components (Figure 1.3), which include:  
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Figure 1.2: Four common categories of drought 

 

 

Figure 1.3: Common drought components (Adapted from Sen, 2015) 

1.1.1 Meteorological drought 

The meteorological definition of drought is the most widespread and understood. 

Using the meteorological definition, drought is described singularly as the degree of 

dryness and duration of the dry period experienced. Most popular meteorological 

definitions consider drought as a “…period of more than some particular number of days 

with precipitation less than some specified small amount…” or  as a “…sustained period 

of time without significant rainfall” (Linsley, Kohler, & Paulhus, 1958). 

Meteorological drought is defined as a lack of precipitation over a region for an 

extended time period (Figure 1.4 a). In order to identify a drought event, meteorologists 

rely on calculations made from precipitation data. Drought is either identified as a deficit 

in precipitation in comparison to the average values over the month, or as a cumulative 

precipitation shortage over a period of several months using historical data. 

Drought Type 

Agricultural Hydrological Socioeconomic Meteorological 

Drought Definition Component 

Soil Moisture 
Deficit 

Runoff Deficit Food Deficit 
Precipitation 

Deficit 
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Figure 1.4: Drought types A) Meteorological B) Hydrological C) Agricultural  

(Adapted from Sen, 2015) 

In addition, the way and extent to which meteorological drought is defined 

necessarily depends on location-specific conditions. Thresholds have therefore been 

developed and can be used to distinguish periods of drought and non-drought, although 

thresholds themselves may vary from location to location, and are themselves the subject 

of some controversy. Efforts have been made to identify and apply common elements 

across definitions that could be used to develop a more ‘universal’ definition of 

meteorological drought, although only a few examples are prevalent. Some of the common 

definitions that have nonetheless been developed (Wilhite & Glantz, 1998) include the 

following:  

1)  Less than 2.5 mm of rainfall in forty-eight hours (United States); 

2)  Fifteen consecutive days that received rainfall as much as 0.25 mm (Britain); 

3)  When annual rainfall is less than 180 mm (Libya); 

4)  A period of six days without rain (Bali) 

1.1.2 Hydrological drought 

Hydrological drought can be defined as a significant lack of water in the hydrological 

system that impairs hydrological cycling and functioning. To clarify, hydrological drought 

is a period of inadequate surface and/or subsurface water resources that impair the function 

and/or provision of water for a specific use. Prolonged lack of precipitation can severely 

impact the hydrological system, and can result in soil moisture deficiencies (causing soil 
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moisture drought), reduced level of groundwater (thereby affecting water storage and 

potential for abstraction), lower water levels in surface storage including lakes and 

reservoirs, and a low level of stream flow in rivers. When these elements are combined, 

hydrological drought occurs. The changes in severity from meteorological to hydrological 

drought can be characterized by the following characteristics defined by Van Loon & Van 

Lanen (2012) as follows: 

 Meteorological droughts are combined into a prolonged hydrological drought 

(pooling) 

 Meteorological droughts are attenuated in hydrological stores, for example in 

groundwater (attenuation) 

 A time differential and delay occurs between meteorological, soil moisture, and 

hydrological drought (lag) 

 Droughts are longer in time, moving from meteorological drought to soil moisture 

deficit and then to hydrological drought (lengthening)     

To define the frequency and severity of a hydrological drought, scientists and experts 

rely on the influence of water deficits on the river basin water level. If the quantity of the 

observed runoff is less than the long-term average of water runoff, then the year can be 

quantified as a drought year. Flow in most of the streams in a watershed affected by drought 

will be low. If low-flow persists below a threshold level, then drought can be considered 

to be in progress. Nonetheless, the length (in days) and probability of this length exceeding 

the threshold to define a hydrological drought period varies from place to place and is often 

considered to be specific to individual streams or river basins, thereby complicating 

measurement without an adequate network of monitoring equipment for regular data 

acquisition. Finally, it is crucial to reinforce the concept that hydrological droughts can be, 

but are not automatically, synchronized with the occurrence of either meteorological or 

agricultural drought.  

1.1.3 Agricultural Drought 

Agricultural drought indicates a condition in which a decline in soil moisture is 

observed, resulting in crop losses, and in crop failure in extreme cases, but without 

necessarily having implications for surface water resources. Deficient soil moisture results 

from some of the effects of meteorological and hydrological drought. The key indicator, 

however, is the difference between actual evapotranspiration and potential 

evapotranspiration, which can leave crop plants in a stressed condition. Crop water demand 

is influenced by weather conditions, the water table, varietal characteristics and crop 

phenology, as well as the physical and biological properties of soil, in addition to a farmers’ 

management practices. 

Many of the variables used to study agricultural droughts are derived from the 

characteristics of meteorological drought. These include precipitation shortage, departures 

from normal or other meteorological factors, for example precipitation or 

evapotranspiration. Well-formed definitions of agricultural drought combine, variables 
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including but not limited to precipitation, temperature and soil moisture. Fully operational 

definitions of agricultural drought will consider the varying susceptibility of crops to soil 

moisture at different stages of phenological development, from seeding to maturity. For 

example, low topsoil moisture at the sowing period can impede germination, leading to 

poor plant stands that can ultimately reduce yield. A prolonged deficiency in soil moisture 

can have additional, significant effects. In rain-fed cropping systems, without sufficient 

precipitation to meet the crop water demand, further stress and yield loss can result.  

1.1.4 Socio-economic drought 

Socio-economic drought may be understood as a situation in which water resources 

are insufficient to meet the water demands of a given human population. Socio-economic 

drought is associated with the provision of water as an economic good, and is indicative of 

an inability to source sufficient water for societal and economic demand. Definitions of 

socio-economic also incorporate characteristics from meteorological, agricultural, and 

hydrological drought, though some researchers including Yevjevich (1967), went as far as 

saying that an objective definition is really only possible if the time and space processes of 

prevailing supply and demand factors are taken into consideration because of deration. This 

point is especially relevant because of the capacity of many societies to adapt to drought 

conditions using technology. 

2 Drought detection and assessments  

The objective of drought monitoring is to provide data that can be used in early 

warning systems prior to drought occurrence. Timely and accurate information on potential 

drought episodes is a crucial component of national drought policy (e.g. for water resources 

management) and planning, especially in the sectors of agriculture and environmental 

management, in addition to industry and civil infrastructure. The need for improved 

drought monitoring methods and approaches is highlighted by the severe droughts 

experienced in a number of countries that have resulted in serious economic, social, and 

environmental impacts . Today, most drought monitoring services rely on the use of 

drought indicators to identify drought risks, which are explained in detail below. 

Drought indicators, also called drought indices, include a number of relevant 

parameters used to describe and monitor the different drought conditions. Indicators are 

the result of quantitative measures of one or several drought variables (e.g. precipitation, 

soil moisture, stream flow, groundwater, evapotranspiration, vegetation etc.), which are 

combined into a single numerical value characterizing a specific level of drought. Drought 

indices are a particularly important management and decision-making tool for business, 

policy makers and other public stakeholders. Moreover, they can be a valuable tool in the 

development of an early warning system prior to the onset of drought.  

Various drought indices with different time scales have been developed. For many, a 

drought index is seen as the “prime variable for assessing the effect of a drought and 

defining different drought parameters, which include intensity, duration, severity and 

spatial extent” (Mishra and Singh, 2010). Undeniably, a drought index can be used to 

quantify: (1) the moisture condition of a region and thereby detect the onset and severity 
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of drought events, and (2) the spatial extent of a drought event, thereby allowing for 

comparison of moisture supply. The methods used to monitor drought can be categorized 

into three main classes i.e., traditional drought monitoring by onsite observation of 

hydroclimate variables (e.g. standardized precipitation index), and by remote  

sensing-based methods, including satellite imagery used to construct indices (e.g. the 

normalized difference vegetation index, vegetation condition index, soil moisture deficit 

index), and the land surface model (LSM) method.  

Drought detection and monitoring is challenging because droughts are a slow-

developing phenomena, with an onset and end that are not distinct. In addition, droughts 

are also a factor of spatial and temporal variabilities. Nevertheless, today there are more 

than eighty indices used to describe in the most comprehensible way the various possible 

drought phenomena. Additionally, drought indices are providing the scientific community 

with data supporting drought detection, monitoring and quantification (e.g. intensity, 

duration, spatial extent), which are essential information for a diverse number of decision 

makers.  

Yet, we still don’t have today a single universally accepted drought index. This may 

be due to the three physical possible forms of drought (meteorological, hydrological and 

agricultural), each of which have different definitions. This makes it difficult to agree on a 

single technique to quantify accurately the severity of each type of drought. Hence, each 

index presents its own set of advantages and limitations, depending of the kind of drought 

that is being monitored at a given period of time. Thus, it is important to introduce, explain 

and discuss the most frequently used meteorological, hydrological, agricultural as well as 

satellite-based indices.  

 

Figure 2.1: Approach in drought monitoring system 

2.1 Remote Sensing for drought characterization 

Remote sensing for drought monitoring and early warning involves data collection 

and analysis of both meteorological and vegetation conditions. 

In-situ observations 

Land surface simulations 

Remote sensing products 

Drought impacts 

SPI 

SMP 

SRI 

NDVI 

Meteorological drought 

Agricultural drought 

Hydrological drought 

Socioeconomic drought 

Inputs Drought Indicators Drought Types 
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Figure 2.2: Components of hydrologic cycle relevant to drought estimated from satellite remote 

sensing (Wardlow, et al., 2012) 

2.1.1 Vegetation monitoring 

The previously seen drought definitions –meteorological, hydrological and 

agricultural –imply that various factors, from precipitation to vegetation condition, need to 

be monitored to identify drought episodes. Vegetation condition is a good indicator of the 

effect of climate soil moisture, and agricultural management practices on water deficit. 

Comparing the state of a current vegetation index to its long-term average can help identify 

drought and contribute to an early warning system. Therefore, satellite-based images are 

indispensable in the detection of changes in the canopy.  

There are three satellite-based indices used to assess vegetation condition. By extension, 

each of these indices help in drought identification. Indeed, drought is usually associated 

with plant vegetation. As such, the following drought indices are most common: 

 Indices derived from the optical domain (e.g. NDVI, the vegetation condition 

index, etc.) 

 Indices derived from the thermal channels of the electromagnetic spectrum (e.g. 

temperature condition index) 

 Indices derived from a combination of the previous indices (e.g. vegetation health 

index) 

Today, the Normalized Difference Vegetation Index (NDVI) is the most utilized 

global-based index. This is due to its near real-time information provision as well as 

simplicity in utilisation and understanding. The NDVI is presented in the form of a simple 
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graphical indicator that can be used to analyse remote sensing data (generally obtained by 

satellite, but not exclusively) to indicate the presence and conditions of green vegetation. 

NDVI is also correlated with precipitation, which drives plant growth (Figure 2.3). Many 

studies have explained the link between the red and near-infrared reflected energy and the 

quantity of vegetation on the ground. Indeed, the reflection of red energy decreases with 

plant development and growth. On the other hand, the near-red infrared reflected energy 

increases with the development of healthy vegetation. Still, the quantity of red and near-

infrared red energy reflected by the vegetation and received by the satellite can be distorted 

by various “pollutants” (e.g. solar irradiance or atmospheric conditions) and plant canopy 

characteristics (e.g. composition, structure etc.). This makes it impossible to simply rely 

on the reflected energy as an indicator of the overall vegetation condition as linked to 

moisture deficits. To work around this problem, the currently used NDVI, is based on the 

ratio difference between the red band and the near-infrared (NRI) and their sum, as follows: 

𝑁𝐷𝑉𝐼 =  
(𝑁𝑅𝐼 − 𝑅𝐸𝐷)

(𝑁𝑅𝐼 + 𝑅𝐸𝐷)
 

It is important to note that spectral reflectance are themselves ratios of the reflected 

radiation for each spectral band with value from 0.0 to 1.0. Thus, the value of the NDVI 

can be found between -1 and +1. The use of “ratio” helps in cancelling out a significant 

amount of signal variation linked to calibration or change in the irradiance conditions, 

resulting from various meteorological phenomena such as sun angle or shadow cast by 

clouds.  

Even in the case of densely populated urban areas that would typically lack 

considerable amounts of vegetation, the NDVI value is positive or closer to zero rather than 

negative. A negative NDVI value is usually the result of changes in atmospheric conditions.   

 

Figure 2.3: Comparison of average precipitation with coincident NDVI 

(Adapted from (Wardlow et al., 2012) 
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Recent studies have also shown that comparisons of extend times series of NDVI data can 

help in drought monitoring in a region. The NDVI calculated over several years during the 

growing season of a plant, can be used as the baseline of the vegetation conditions, whereas 

the coefficient of variation in NDVI is used to visualize the variation between the growing 

seasons. Such studies can help in assessing current vegetation conditions in simple formats 

that can be easily understood, for example including conditions that are “above”, “below”, 

or “near normal”, with “normal” usually being defined as the historical average. 

2.1.2 Surface temperature estimation 

Land surface temperature (LST) also derived by satellite data and can be used as a 

drought index. LST is derived from the range of frequencies in the electromagnetic 

spectrum, with each range called a ‘band’). The LST is further used to formulate the 

relationship between emitted energy and the water budget of the Earth’s surface-

atmosphere interface (Gutman 1990). Therefore, LST data can help in assessing 

evapotranspiration, soil moisture and vegetation water stress. LST can also be used as 

another source of information on the Earth vegetation conditions. This idea lead to the 

development of the temperature condition index (TCI), based on temperature brightness 

value data.  A higher LST is indicative of soil moisture deficiency and thus potentially 

moisture limiting conditions for vegetation.  

2.1.3 Soil moisture estimation 

Soil moisture plays an important role in Earth hydrological processes and more 

precisely in the water and energy budget estimation conducted in the climate studies. Its 

accurate estimation over time and space is crucial in a wide range of agricultural and 

environmental studies. The advancement of technology has allowed increased use of 

various remote sensing techniques to measure soil moisture. Among others, microwave 

sensing (both passive and active microwave) is the most commonly used approach for 

remote sensing inference in soil moisture analysis.  

All earthly objects emit microwave energy (passive microwaves) in small amounts. 

These are related to the temperature and moisture properties of the emitting surface or 

object. A passive microwave sensor, via its antenna, can detect and record naturally emitted 

energy waves. Recorded energy can be emitted/reflected by the atmosphere, the Earth’s 

surface or its subsurface (2 to 5 cm). Recording of passive microwaves can be used to 

quantify (via various algorithms) soil moisture as the amount of moisture that has a direct 

impact on the emitted quantity of microwaves from an object, including the Earth’s surface. 

However, since the amount of emitted energy is generally low, the fields of view of the 

sensor must cover a large enough area of the Earth to be able to record an emission signal. 

This results in a lower spatial resolution when soil moisture is measured using microwave 

radiation, which to some extent limits usefulness. 

We however now have to our disposition a number of various tools, such as the 

Scanning Multichannel Microwave Radiometer (SMMR), Special Sensor 

Microwave/Imager (SSM/I), Tropical Rainfall Measuring Mission (TRMM) Microwave 

Imager (TMI), Advanced Microwave Scanning Radiometer on the Earth Observing System 

(AMSR-E), and Soil Moisture and Ocean Salinity (SMOS) sensor. These tools can be used 
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to measure the natural emission of microwave energy from the land surface (Wang, 1985; 

Owe et al., 1988; Kerr and Njoku, 1990; Teng et al., 1993; van de Griend and Owe, 1994; 

Engman, 1995; Jackson, 1997; Kerr et al., 2001; Njoku et al., 2003). 

Conversely, an active microwave sensor provides its own source of microwaves 

used to illuminate a given target (e.g this is the case with RADAR). Sensors emit a 

microwave directed towards the earth’s surface, which are then reflected by Earth and 

return to the sensor. The physical properties of the Earth’s surface or object will in turn 

influence the amount of microwave energy that is reflected back to the sensor.   

Overall, both techniques are based on the changes in soil permittivity, which is in 

turn linked to the amount of liquid water contained in the soil. Indeed, microwave energy 

emitted or reflected by the soil to the sensor depends on the soil dielectric constant 

(permittivity) and consequently soil moisture. Moreover, scientists have developed models 

to relate water volumetric content of the different soil types to their dielectric constant. It 

is therefore is possible to estimate soil moisture based on the captured microwaves linked 

to the soil dielectric constant. This approach however must be treated with caution, as 

different variables including vegetation, rainfall, soil surface roughness, etc. can have an 

impact on the level of accuracy of soil moisture estimated from detected microwaves.  

2.1.4 Rainfall Monitoring  

Rain is one of the determining factors of drought. Compared to conventional 

method of measuring precipitation through physical capture of rainfall, remote sensing 

allows for a broader spatial estimation of precipitation. Though still experimental, satellite-

based rainfall estimation methods (based on cloud studies) have already shown some 

promising results and can be grouped into three categories, including (1) visible and 

infrared techniques, (2) passive microwave techniques,  and (3) active microwave 

techniques, each of which are reviewed below. 

Visible and Infrared sensor (wavelengths between 0.4 and 0.7μm):  

The human eye is unable to detect existing radiation. Satellite sensors can however 

detect both visible and invisible radiation. Rainfall estimation methods, based on visible 

and infrared radiation, can be divided into several sub-categories, including cloud-

indexing, bi-spectral radiation, and life history and cloud models. Each of these categories 

relies on specifically physical properties of clouds. The most commonly used approach is 

the cloud indexing technique. In cloud indexing, an algorithm is used to assign a level of 

rainfall to each cloud observed in a satellite image. 

The thicker a cloud, the less that sunlight will be able to pass through it. Similarly, 

the thicker a cloud formation is, the more radiation it will reflect back to a given satellite. 

A thinner cloud will allow more solar radiation to pass through, and therefore will reflect 

less back to an intercepting satellite. Seen from the ground by the human eye, thicker clouds 

are darker, whereas on the satellite imagery, they will be brighter (due to a higher amount 

of reflected radiation) than a thinner cloud formation. Clouds with a higher level of 

reflection are therefore thicker, and indicate a higher probability of rainfall. In addition, 

this method allows users to calculate the monthly rainfall (Rr) for a region by using the 
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past history of recorded images of clouds with greater probability of rain. The number of 

days (Nd) during a month that cloud formations covered a particular region, indicative of 

regional rainfall potential, can also be calculated. This is accomplished using the equation 

below:  

𝑅𝑟 = 62.6 + 37.4𝑁𝐷 

Another technique to predict the potential of rainfall a given cloud formation (or 

more accurately each pixel of satellite image) is related to cloud temperature. This method 

was developed by Arkin (1979), and is based on the concept that colder clouds are generally 

more likely to be associated with rainfall potential than warmer ones. This is because cooler 

clouds tend to have higher elevation tops. Because rain originates from the top of a cloud, 

clouds with high elevation tops will tend to have a higher rainfall potential. Accordingly, 

rainfall have a higher probability of originating from clouds that have cooler temperatures, 

high tops and that have deep convection characteristics (e.g. cumulonimbus clouds). 

Satellite images retrieved from reflected radiation from clouds can be used to determine 

cloud temperature depending on the wavelength of the reflected radiation, and thereby if a 

cloud has a higher potential to rain (or not). This means that rainfall probability as well as 

its intensity can be predicted, with a certain amount of accuracy, by using satellite based 

clouds images.  

In summary, the first technique helps in the identification of the cloud type, area 

and growth, while the second technique provides information on clouds top temperature 

and growth rate. Table 2.1 shows rainfall estimates derived from visible/infrared data based 

on a cloud Indexing method, where Intensity values are assigned to different cloud types 

in an area.  

Table 2.1 : Rainfall probability estimates by cloud type (Source: Kidd, 2011) 

Cloud Type Relative probability of rainfall Relative intensity of rainfall 

Cumulonimbus 0.90 0.80 

Stratiform 0.50 0.50 

Cumuliform 0.10 0.20 

Stratocumuliform 0.10 0.01 

Cirriform 0.10 0.01 

Clear Skies 0.00 0.00 

 

𝑅𝑟 = ∑ 𝑟𝑖𝑓𝑖

𝑖

 

where Rr is the rainfall rate, 𝑟𝑖 is the rain rate assigned to cloud type i, 𝑓𝑖 is the fraction of 

time (or fraction of area covered) by cloud type i. 

Finally, the life-history approach is based on the use of visible and infrared 

radiation images with a higher temporal resolution to track a cloud development and 
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trajectory, and to relate these to rainfall probability. Based on the temperature of the cloud 

and its past development, it is now possible to relatively accurately understand its 

upcoming growth stages and adjust anticipated rainfall and forecasts accordingly.  

Passive microwave technique:  

Precipitation particles are responsible for the change in cloud emitted radiation 

measurable from the tops of clouds by satellite. Indeed,  “…the emission of radiation from 

atmospheric particles results in an increase of the signal received by the satellite sensor 

while at the same time the scattering due to hydrometeors reduces the radiation stream” 

(Levizzani et al., 2001). As such, radiation measured above 60 GHz indicates the presence 

of ice crystals in the cloud. This is because satellite sensors are currently only be able to 

detect ice due to its higher radiation scattering effect in comparison to rain droplets. If a 

measured radiation value is between 19.3 and 85.5 GHz, a higher amount of liquid rain 

droplets are likely to be in the cloud in question. The most popular instrument used in 

microwave rainfall monitoring is the SSM/I. This sensor can measure clouds emitted 

radiation over a span of 1,400 km, indicative of the utility of the SSM/I. However, the 

disadvantage of SSM/I instrumentation and associated methodologies lays in its low 

quality of spatial and temporal resolution, despite the large distance that can be measured. 

Diffraction limits the ground resolution of SSM/I measurements, and the interference of 

other types of radiation from the sea and land under the complicated reliable measurement.  

Active microwave:  

“The most important precipitation measuring instruments from space is the PR, 

precipitation radar operating at 13.8 GHz on board TRMM, the first of its kind to be flown 

on board a spacecraft. The instrument aims at providing the vertical distribution of rainfall 

for the investigation of its three-dimensional structure, obtaining quantitative 

measurements over land and oceans, and improving the overall retrieval accuracy by the 

combined use of the radar, and the TMI and VIRS instruments”. 

2.2 Drought indices 

In general, most practical indicators of drought describe the magnitude, duration, 

severity, or spatial coverage extent water deficit. They are based on meteorological and 

hydrological variables, including precipitation, temperature, stream flow, soil moisture, 

reservoir storage, and groundwater level, among others. Some indicators can be combined 

and synthesized into a single index, most commonly called a drought index. Today, we can 

classify the existing indicators into two categories, according to their primary concern, 

which is either environmental or linked to water availability.   

Environmental indicators are related to hydro-meteorological and hydrological 

conditions and measure the direct effect of drought in impairing the functioning of the 

hydrological cycle. Among the most significant indicators are deficits (dry spells), either 

in precipitation or stream flow or soil moisture, or in combination. These indicators define 

the frequency of drought occurrence and characteristics including drought duration and/or 

severity. Nonetheless, to accurately define these indicators, a threshold level is required. 

The most common threshold is developed using the arithmetic average or water demand 
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level, but any other convenient water demand measurement also be adapted and adopted 

in use. 

Water resources indicators quantify drought severity considering overall water 

deficit impacts on hydrological resources (surface or groundwater) that supply domestic, 

agricultural, and industrial uses. They also consider the effect of deficits on groundwater 

recharge, abstraction potential and sustainability, and surface water levels (especially those 

stocked in reservoirs). Water resource-related drought indicators are dependent not only on 

natural variation or cessation of rainfall, but also on the human interference in the 

hydrological cycle, for example a steady increase in water demand in a particular area in 

comparison to limited supply or recharge capability. Apart from a lack of rainfall or runoff, 

poor water resource mismanagement or excessive abstraction without adequate attention 

paid to sustaining recharge exacerbate drought severity.  

2.2.1 Standardized precipitation index 

The Standardized Precipitation Index (SPI) was developed to assist in drought 

definition and monitoring. As such, it is not a drought prediction tool. The main goal of the 

SPI is to allow climatologists to determine the rarity of a drought for a particular time scale, 

and also to identify periods of abnormal wet events. The SPI is based on a cumulative 

distribution function (CDF), established using previously observed historical data for 

precipitation events occurring at a particular observation point or points. In other words, 

once converted to a CFD, SPI represents the probability of rainfall distribution at a given 

station. Historical data is crucial in that it allows analysts to tell how likely wise it is for a 

rainfall event to be less to or equal to a certain amount of precipitation previously observed 

at different timescales. Therefore, if a particular rainfall event scores low on the probability 

on the CDF, it is an indication of a possible drought episode (drought here being 

characterized as a “below-normal” rainfall event). In contrast, a rainfall event with a high 

probability on the CDF will indicate an abnormally wet situation.  

Each probability function, defined for a given station, will have its own standard 

deviation depending on the rainfall characteristics of the area the station is located in. Thus, 

each standard deviation will differ from one another, making the comparison of rainfall 

events for different areas challenging. For example, a rainfall qualify as “normal” for one 

area can be a surplus or a “below-normal” rainfall event in another area. To solve this issue, 

the cumulative probability function can be transformed into a standard normal function in 

a way that each rainfall amount in the old function has a corresponding value in the new 

function. The conversion process also conserves all the probability rainfall deviations from 

the old function in the new function. Moreover, this transformation can be done with all 

the probability functions calculated for the different rainfalls and for the different stations, 

which will result in a single standard normal distribution function, the SPI (figure 2.4).   
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Figure 2.4: Transformation of the observed rainfall via the Gamma cumulative distribution 

function (CDF) and the CDF of the standardized variable to the standard precipitation index (SPI) 

Therefore, the SPI is a “normalized” index representing the probability of 

occurrence of an observed rainfall amount when compared with the historical climatology 

at a certain geographical location of interest when measured over a reasonably long-term 

reference period. When an SPI value is positive relative to the threshold, it indicates a 

rainfall surplus. Conversely, a negative value indicates a rainfall deficit, which can in turn 

be used to classify the intensity and severity of a drought event.  

Table 2.2: Standard precipitation index classification 

SPI Value Class Cumulative Probability Probability [%] 

SPI ≥ 2.00 Extreme wet 0.977 – 1.000 2.3% 

1.50 < SPI ≥ 2.00 Severe wet 0.933 – 0.977 4.4% 

1.0 SPI ≥ 1.50 Moderate wet 0.841 – 0.933 9.2% 

-1.00<SPI≥1.00 Near normal 0.159 – 0.841 68.2% 

-1.50 < SPI ≥ -1.00 Moderate dry 0.067 – 0.159 9.2% 

-2.00 < SPI ≥-1.50 Severe dry 0.023 – 0.067 4.4% 

SPI < 2.00 Extreme dry 0.000 – 0.023 2.3% 

In summary the strengths and weakness of the SPI are as follows:  

Strengths  

•  Flexibility: SPI can be computed for multiple timescales  

•  Shorter timescale SPIs, for those that span 1-, 2- or 3-month SPI periods, can be 

used to infer early warning of drought and also help to assess drought severity  
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•  SPI is spatially consistent, allowing for comparisons between different locations in 

different climates  

•  Because SPI is associated with a probability, it is very suited as a tool for decision-

making.  

Weaknesses  

•  SPI is based only on precipitation, and does not incorporate other variables that 

may be associated with drought 

• SPI lacks a soil water-balance component, thus ratios calculating 

evapotranspiration to potential evapotranspiration (ET/PET) can’t be calculated. 

This undermines the utility of this measurement method for agricultural decision 

making in particular. 

2.2.2 Palmer drought severity index (PDSI) 

The so-called Palmer Drought Severity Index (PDSI) quantifies the degree of 

aridity of a soil by using information on temperature and precipitation. PDSI can be applied 

in the comparison on different locations and time-scales, and can be used to assess the 

length and severity of a drought. In order to achieve this goal, a water balance equation can 

be applied that uses strings of supply and demand variables, the latter which is comprised 

by data on temperature, relative humidity, groundwater, soil-available water, etc.). The 

calculation of PDSI approximates supply and demand variables over a given period of time, 

which is often around one calendar year, and results in estimates of evapotranspiration, 

runoff and the soil-water balance from the soil surface at a specific time of interest in 

relation to cumulative past conditions.  

Measurement of PDSI can range from -4.0 (extreme drought) to +4.0 (no moisture 

deficits) and is universal regardless of location.  

Table 2.3s: The PDSI classification ranges  

Palmer Drought Severity Index (PDSI) classifications 

4.0 or more Extremely Wet 

3.0 to 3.99 Very Wet 

2.0 to 2.9 Moderately Wet 

1.0 to 1.99 Slightly Wet 

0.5 to 0.99 Incipient Wet Spell 

0.49 to -.49 Near Normal 

-0.5 to -0.99 Incipient Dry Spell 

-0.1 to -1.99 Mild Drought 

-2.0 to -2.99 Moderate Drought 

-3.0 to -3.99 Severe Drought 
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-4.0 or less Extreme Drought 

The PDSI has several benefits:  

- PDSI is useful in determining long-term drought, especially for locations in the 

low and middle latitudes. 

- PDSI uses models of surface air temperature and a physical water balance and can 

be used in the consideration of climate change effects through changes in potential 

evapotranspiration.  

- PDSI considers prior conditions (data from the prior month of observed weather 

and hydrological information are utilized).  

Nevertheless, also has several weaknesses:  

- PDSI performs poorly in cross regional comparisons. Performance can however be 

improved through model calibration.  

- PDSI is deficient in multi-timescale indices (like SPI). This make it difficult to 

correlate PDSI results with specific water flow and storage reservoirs, for example 

runoff, ice or snowpack, lakes and reservoirs, etc. 

- Delays in runoff that originate with snowpack or ice are not considered.   

2.2.3 Surface water supply index (SWSI) 

Developed by Shafer and Dezman (1982), the surface water supply index is used 

to identify and monitor hydrological drought events. SWSI is based on the concept of 

“monthly non-exceedance” of probability (for example, maximum water supply 

probability) from historical datasets of reservoir storage, stream flow, snow and ice pack, 

and precipitation. These data sources constitute the primary inputs used in calculating 

SWSI.  

SWSI is mainly used for monitoring abnormalities in surface water supply and its 

influence on available water in reference to seasonal hydrological drought. The latter point 

is important, as the equations that govern the SWSI are written to ‘switch on’ or ‘switch 

off’ flow from snowpack in the summer and winter, respectively. Similarly, flows will 

increase or decrease depending on seasonality and intercepted precipitation in watersheds 

leading to surface water flow. The SWSI is however spatially and temporally variable, and 

has differing statistical characteristics depending on the region and climate in which it is 

applied. 

2.2.4 Vegetation condition index 

The most commonly used Normalized Difference Vegetation Index (NDVI), helps 

in drought monitoring by detecting anomalies in the canopy conditions. Anomalies can be 

defined as the difference between the NDVI composite value for a specified time period 

(e.g., weekly, biweekly, or monthly) and the long-term mean value for that period. Thus, 

the variation in the present-day vegetation conditions can help to identify and established 

the severity of a current drought event.   
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Therefore, the vegetation index allows to acquire important information on the time of 

drought onset and end, intensity, duration and overall impact of vegetation. But, since the 

vegetation condition index is based on vegetation, it is primarily useful for the summer 

growing season and has a limited utility for cold seasons when vegetation is largely 

dormant (Heim, 2002). 

In, 1993 Kogan and Sullivan introduced a vegetation index-based drought metric 

(the VCI), based on the NDVI, that could be used as a global drought monitoring and 

warning system. The VCI is defined as follows: 

𝑉𝐶𝐼 =
100(𝑁𝐷𝑉𝐼 − 𝑁𝐷𝑉𝐼min )

𝑁𝐷𝑉𝐼𝑚𝑎𝑥 − 𝑁𝐷𝑉𝐼𝑚𝑖𝑛
 

Where NDVI, NDVImax, and NDVImin are values of the smoothed weekly NDVI and the 

multiple-year NDVI maximum and minimum, respectively. A low value of VCI would be 

an indication of a stressed vegetation due to unfavourable weather conditions, while a high 

value of VCI indicates healthy vegetation conditions.  

2.2.5 Temperature Condition Index (TCI) 

A study conduct in India has put into light the value of combining the VCI with 

the Temperature Condition Index (calculated from terma channels), to improve drought 

event prediction. The TCI is defined as follows:   

𝑇𝐶𝐼 =
100(𝐵𝑇𝑚𝑎𝑥 − 𝐵𝑇)

𝐵𝑇𝑚𝑎𝑥 − 𝐵𝑇𝑚𝑖𝑛
 

Where BT, BTmax, and BTmin are the smoothed weekly and multiple-year maximum and 

minimum thermal brightness temperatures, respectively.  

Further studies confirmed that the TCI performed better than NDVI and VCI, 

especially in cases of excessive soil moisture caused by heavy rainfall or persistent 

cloudiness. Indeed, these conditions can result in a low value for the VCI and NDVI and 

be interpreted erroneously as drought. In order to solve the problem of a false positive for 

drought, Kogan developed in 1995 a third VCI (VHI, Vegetation Health Index), by 

combining the VCI and TCI. VHI is expressed as follows: 

𝑉𝐻𝐼 =∝× 𝑉𝐶𝐼 + (1−∝) × 𝑇𝐶𝐼 

Where α is a coefficient determining the relative contribution of the TCI and VCI. 

So, VHI is a proxy characterizing vegetation health by combining estimation of moisture 

and thermal conditions. 

2.2.6 VegDRI Concept 

VegDRI was developed following an integrated approach to capitalize on the 

strengths of both satellite and climate-based indices traditionally used for drought 

monitoring. Therefore, the VegDRI measures the effects of drought on vegetation by 

blending in its analysis, the general vegetation conditions observed in satellite-derived VI 

(vegetation index) data and the level of dryness from the climate-based drought indices for 

a specific location. The VegDRI contains a set of eight identified input variables that can 
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be divided into three mains categories: satellite, climate, and biophysical. The two variables 

related to general vegetation conditions – the Percent Average Seasonal Greenness (PASG) 

and Start of Season Anomaly (SOSA) –are calculated from satellite-based observations 

and incorporated into the VegDRI. Both variables are calculated from NDVI data to 

monitor and quantify seasonal vegetation dynamics. In addition, other important 

biophysical and environmental characteristics are incorporated in the index as they can 

have a direct influence on the climate-vegetation dynamic.  These biophysical data are soil 

available water capacity (STATSGO database), land cover/land use type (USGS National 

Land Cover Dataset), national irrigated lands map derived from 250-meter MODIS satellite 

data, ecoregion type,  and elevation (USGS National Elevation Dataset). The climate data 

used for the VegDRI is the 36-week SPI that was found to be highly correlated for the 

Continental United States (CONUS). 

 

Figure 2.5: Workflow diagram for VegDRI 

Based on a modified version of the PDSI classification system (Palmer, 1965), the 

VegDRI values are classified into four dry categories including three classes of drought 

severity (moderate, severe, and extreme), and a pre-drought class that represents the dry 

side of the near-normal class value range (see Table 2.4). The pre-drought class was added 

to identify region that could be nearing a situation of droughtiness.  Although, the four non-

drought classes (normal, unusually, very, and extremely moist) are characterizing locations 

with normal to better than normal vegetation conditions, they can also spot areas of 
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excessively wet condition that could result in poor vegetation health due to flooding or 

waterlogging. Finally, an “out of season” (OS) class was elaborated with the aim to identify 

periods of time when the vegetation is dormant (e.g. winter) and for which the VegDRI 

values are not calculated. 

Table 2.4: VegDRI Classification Scheme and Class Value Ranges 

VegDRI Class Names Value Range 

Extreme drought <-4 

Severe drought -4 to -3 

Moderate drought -3 to -2 

Predrought -2 to -1 

Near normal -1 to +2 

Unusually moist +2 to +3 

Very moist +3 to +4 

Extremely moist >+4 

2.3 Criteria for Selecting Drought Indices for monitoring Drought  

Availability of large number of drought monitoring indices, call for the need of the 

development of objective criterion to easily identify the most suitable drought index for a 

specific application. The table below, summarized the commonly used criterion to 

demarcate the drought indexes.  

Table 2.5: Criteria for selecting Drought Monitoring Indices 

Criteria Weight 

Robustness 0.28 

Tractability 0.21 

Transparency 0.17 

Sophistication 0.17 

Extendibility 0.10 

Dimensionality 0.07 

Note: Adapted from (Keyantash and Dracup 2002) 

Robustness  

Robustness is related to the usefulness of the index for a wide range of physical 

conditions. Still, the robustness alone does not weight more than the other criteria in the 

process of selecting a drought index.  

Tractability  

Tractability of an index refers to the practical use of the index by an individual. An 
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intractable index would require a more complex and higher-level of numerical computing 

and thus calls for higher level of knowledge from the person using the index.  

Transparency 

Transparency can be understood as the level of clarity of the objective and rationale 

behind the drought index. A good drought index is not only understood by the scientific 

community, but likewise by the end users of the drought information as well. Hence, 

transparency represent the general utility of an index (Keyantash & Dracup, 2002). 

Sophistication 

Sophistication is somewhat at odds with transparency, but it has nevertheless been 

included because of the conceptual merits of an approach. The level of sophistication 

incorporated in a drought index must be supported by the quality of the available data and 

the fundamental accuracy of the assessment method. 

Extendibility 

This criterion represents the degree to which an index can be extend across time to 

alternate drought scenarios. An index based on simple basic measured data (e.g., 

temperature or precipitation) can be used for a longer historical periods than a drought 

index relying on satellite data. Another aspect of extendibility of a drought index relates to 

the possibility of using the primary index with other indices to refine the drought 

assessment.  

Dimensionality 

It refers to the connection of the index with the physical world. An index with 

fundamental units or a ration of computed physical units (e.g. percentage, probabilistic unit 

etc.) for indices, instead of only simple dimensionless qualities, can be used more readily 

to compare features between different location and time periods.  

Suitability 

This reference to the ability of an index to reproduce specific drought events and 

impacts (e.g., on vegetation, agriculture, water levels ...). Thus, a highly suitable index 

captures the important information related to drought for a specific sector of activities (e.g. 

agriculture and crop water information).  

2.4 Data Requirement for Drought Monitoring 

Drought data requirements depends on the drought index system that is being 

designed. Different factors can affect the data requirement for a drought monitoring index 

such as the type of drought, spatial and temporal resolution etc.  

Table 2.6: Factors to be considered for drought monitoring design 

Design Type Observation, data integration 

Measurement Type Meteorological drought index, agricultural drought index, hydrological 

drought index, integrated drought index 
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Technology type Data transformation 

Factor Type Observation period, temporal resolution, spatial resolution 

Sample characteristics Global, regional, local 

Due to drought various impacts, different meteorological, hydrological and 

environmental variables can and are necessary for its accurate monitoring. Moreover, as 

droughts phenomena vary with time and space, as single variable would not be able to 

provide enough information on this particular event.  

Table 2.7: Data categories used for drought monitoring and prediction 

Data Category Frequency of 

Data Collection 

Variables Indices 

Meteorological 

Observation  

Hourly to annual Precipitation, Temperature, 

wind speed, humidity,  

Decile, SPI, 

Rainfall anomaly, 

PDSI, TCI 

Hydrological 

variables 

Hourly to annual Stream flow, ground water 

level, reservoir/lakes levels, 

snow 

Surface Water 

Supply Index 

(SWSI), PHDI 

Environmental 

Variables  

Hourly to annual land cover, land use, 

vegetation health/stress, 

yield, fire 

NDVI, VCI 

Soil Moisture Hourly to annual Moisture Soil Moisture 

Anomaly Index 

Precipitation, temperature and vegetation datasets 

APHRODITE 

Asian Precipitation Highly Resolved Observational Data Integration Towards 

Evaluation of Water Resources (APHRODITE), present a 0.25° spatial resolution over the 

Asian Monsoon region (V1101R1) for the period of 1981–2007. These data were created 

by using a station-based observation presenting a good spatial variability and representing 

also other rainfall characteristics (e.g. orographic rainfalls). Additionally, APHRODITE 

data have undergone a thorough quality control for inconsistencies and errors.  

CHIRPS 

The Climate Hazards Group InfraRed Precipitation with Station data (CHIRP/S) 

provides precipitation data at  0.25° and 0.05° spatial resolutions, in an almost near real-

time manner and on a daily- bases for a total of 5 days. These data are the result of a 

combination between different products, mainly the monthly precipitation climatology 

(CHPClim, which represents the long-term historical average rainfall accumulation), 

Thermal Infrared (TIR) satellite observations (or from globally gridded Satellite such as 

GriSat), and in situ precipitation observations from various national and regional 
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meteorological departments (C Funk et al., 2015).  

The CHIRPS project generates both a preliminary and a final product. The 

preliminary product comes out two days after the end of the pentad and consists of the 

combination of CHPClim, TIR satellite and available stations. Station data could be from 

in-country organizations such as meteorological services or/and from the Global 

Telecommunication System. The final product is processed two weeks after the end of the 

month with a greater number of stations from different sources.   

MOD11A2: MODIS/Terra Land Surface Temperature/Emissivity  

The MODIS LST products provide data for a daily, eight-day and monthly basis 

time frame.  The MOD11A2 product provides a LST information for an average of 8-day 

per-pixel land and with a resolution of 1200 x 1200 kilometre grid. Each pixel value in the 

MOD11A2 is a simple average of all the corresponding MOD11A1 LST pixels collected 

within that 8-day period (for both night and day time).  

The table below, summarizes the main characteristic of each products for drought 

monitoring.  

Table 2.8: List of source data products for regional drought monitoring systems 

SN 
Data / Product 

Spatial 

Resolution 

 Temporal 

resolution 
Description 

1 CHIRP rainfall 5 km  10 days Gridded rainfall data product 

2 

MOD13Q1 Vegetation 250 m  16 days 

NDVI Maximum Value Composite 

(MVC) based on 16 days along with 
Quality tags 

3 MOD11A2 Land 

Surface temperature 
1 km  8 days 

Land Surface Temperature (LST) 

MVC based on 8 days  

4 Soil moisture 5 km  daily SALDAS derived data 

5 Evapotranspiration 5 km  daily SALDAS derived data 

6 In-situ Rainfall Data point  daily Ground station met data 

 

  



24 

MOD13Q1 

Global MODIS vegetation indices are aiming at providing a consistent spatial and 

temporal comparisons of vegetation conditions on earth, by using blue, red, and near-

infrared reflectance information. This product can help in monitoring the overall Earth 

photosynthetic vegetation activity, detect changes and interpret the occurring biophysical 

activities.  The MODIS is using a gridded vegetation index maps to visualize spatially and 

temporally vegetation changes, with a 16-day and monthly intervals.  

When producing a single 

MOD13Q1 dataset, the MODIS 

algorithm is designed in way to 

select the best pixels from a 

choice of sixteen days of images, 

in order to reduce the amount of 

pixels that are partially or 

completely obscured by clouds 

or other atmospheric 

contaminants. 

 

Time series NDVI data 

cleaning and processing 

In theory, the NDVI 

calculated from a normalized 

transformation of the red and 

near-infrared reflected radiations, 

are an accurate value to estimate 

the changes in canopy condition. 

However, the capture of the 

reflected radiation by the satellite, 

can be affected by contaminants 

such as clouds, changes in the 

atmospheric conditions or by the 

bidirectional effect. 

Subsequently, these disturbances 

can affect the drought monitoring 

activity. For this reason, in the 

past few years, several methods 

were tested and developed to 

reduce the noises caused by the 

contaminants and resulted in a 

higher quality NDVI time-series 

data set, more suitable for further 

analysis.  

Figure 2.6: Comparison of process and un-processed 

data 
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We can distinguish three main group of methods used to reduce the noises in the data:  

 The threshold-based methods such as the best index slope extraction algorithm (BISE). 

The BISE algorithm is used to extract seasonal metrics of vegetation phenology, 

classify the type of land cover, and estimate the gross primary productivity (GPP).  

 The Fourier-based fitting methods. This method is used to derive terrestrial biophysical 

parameters in order to evaluate the NPP dynamics. 

 The asymmetric function fitting methods such as the asymmetric Gaussian function 

fitting approach and the weighted least-squares linear regression approach, are mainly 

used to extract seasonality information for phenological studies.  

 

Figure 2.7: Flowchart for NDVI impurities correction 

The Fourier-based fitting method 

In a closed interval [0; L], each continuous and periodic function f(t) can be 

decomposed into a series of harmonic components (sine and cosine waves) with increasing 

frequency. This method is termed Fourier analysis and has been modified to be applicable 

to discrete time-series data, like the NDVI of a given pixel (Jakubauskas, Legates, & 

Kastens, 2001), (Wagenseil & Samimi, 2006). It can mathematically represent by the 

formula below: 

MODIS L and Product MOD 13Q1 

Data Quality Time-Series Data 

Data Quality Fourier Curve Fit 

Save high quality image for data 
validation 

Adjust weight from first attempt 
(reduce errors) 

MODIS Smoothened and Gap filled 
data at 250m 

Time Series Smoothed Results of 11 
Years data 
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Where f (t) is the NDVI of a given pixel location at time t (1 year = 23 16-days MVCs, t = 

[1..23]);  is the mean of f (t) in [0; L], additive term; n is the harmonic term; An is the 

amplitude of the nth harmonic; Φn is the phase angle of the nth harmonic; and L is the length 

of the observation period (L=23). 

 

Figure 2.8: (a) Simple cosine curve representative of first harmonic (b) curves for harmonic terms 

1, 2 and 3 (c) Curve produced from adding three harmonic curves 

The Fourier analysis is a particularly suitable technique for parameterization of NDVI 

time series for the following reasons: 

 The non-periodic and infrequent radiometric noise (e.g. from atmospheric 

attenuation, pre-processing errors) is restricted to higher terms (the Maximum Value 

Composites).  

 Parameters of lower Fourier terms can be understood as the vegetation growth 

pattern. This is a suitable measure of the overall greenness for a given pixel location.  

 The amplitude values quantify the degree of seasonal biomass production, whereas 

the number of the corresponding term is related to the number of peaks during the 

observation period. The phase angle describes the time lag between origin and peak 

and captures the date of maximum greenness.  

But, this method also contains some weakness that are worth mentioning. Admittedly, the 

Fourier analysis is based on the assumption of a periodical and sinusoidal signal, which is 

not strictly satisfied by the NDVI of a certain location. Vegetation growth pattern results 

usually in a complex shape of NDVI, not always sinusoidal and which might require a 

higher frequency terms for suitable approximation. Even though, this higher terms can be 

linked to growth patterns of secondary cover types, their meaning is generally not 

straightforward. Thus, interpretation in this study in relation to vegetation growth is mainly 

restricted to mean and first term parameters.  
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2.5 Weather forecast and drought prediction 

Drought forecasting plays a critical role in understanding drought impacts on water 
balance and thus for decision making for risk management, drought-preparedness and 
mitigation. Despite drought forecasting focusing on different aspects of the phenomena, an 
accurate prediction of the onset and termination point of the event is still remains a major 
challenge. Method in Drought Forecasting. Drought forecasting methods can be divided 
into different various approaches. In this part, we are going to have a brief overview of the 
most commonly used approaches. 

a) Linear regression models: 

  A linear regression analysis allows to explore the relationship between two or more 
quantitative variables: a dependent variable whose value we want to predict and a variable 
for which we do have information available. In other words, a multiple-regression predicts 
one variable from two or more independent variables and can be mathematically written 
by using the following formula:  

Y=a+bX1+cX2+dX3 

Where Y is the dependent variable, X1, X2 and X3 are the independent variables, and a, b, 

c and d are constants. 

In case of drought monitoring, the dependent variable is a drought quantifying 
parameter (i.e., drought index), while the independent variables are explanatory variables 
for the drought-quantifying parameter (i.e., precipitation, soil moisture, temperature 
etc.).Scientist have applied the regression model for agricultural drought analysis and 
forecasting. In that case, the grain yield from the main produced crop was used as a drought 
quantifying parameter while variables affecting grain yield were used as explanatory 
variables. The model can successfully predicted the grain yield of the main produced crop 
before the crop harvesting season and help assess the agricultural drought severity as mild, 
moderate, or severe. 

b) Time series models 

We call a time series models a “ forecasting algorithms that have been used for short-
term forecasting by employing the notions of Markov and autoregressive integrated 
moving average (ARIMA) stochastic models, non-homogeneous Poisson processes 
coupled with conditional probabilities” (Lohani & Loganathan, 1997). In simple terms, 
time series models are using serial linear correlation method to describe non-stationary 
behaviours within and across a given seasons. Furthermore, a time series of a drought 
quantifying parameter can be used for drought forecasting, depending upon the previous 
observations. For example, the two linear stochastic models, ARIMA and SARIMA, were 
developed for drought forecasting (up to two month and with a reasonable accuracy) by 
using the Standardized Precipitation Index (SPI) (other index could have been used as well) 
series as drought quantifying parameter.  

c) Probability models 

Probability models present a more complex nature and can be used to forecast drought 

by quantifying it hydro-meteorological variables. Commonly Markov chain models have 

been used for drought forecasting. A Markov chain is a stochastic process having the 
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property that the value of the process at time t, Xt, depends only on its value at time t-1,X 

t-1,and not on the sequence of values Xt-2, X t-3 ... X0 that the process passed through in 

arriving at Xt-1. Cancelliere, et al., (2007) forecasted seasonal SPI by computing transition 

probabilities from a current drought condition to another in the future based on the statistics 

of the underlying monthly precipitation. 

d) Artificial neural network model 

Neural networks are flexible nonlinear models used to discover patterns in data. In 
theory, a neural network can learn from past experience and estimate complex functional 
relationship in data with a high accuracy if an appropriate number of nonlinear processing 
units is used. However, in general scientist are using three-layer feed-forward models 
(input layer, a hidden layer and an output layer) for forecasting activities. There are three 
possibility of inputs nodes as follow: (i) previously suitable observation of drought 
quantifying time series, ii) explanatory variables for quantifying drought, or (iii) a 
combination of both (i) and (ii). Then, hidden nodes are used to process the information 
received from the input’s nodes. Finally, the output layer is used to formulate forecast for 
different time lead. For example, we could use different combination of past rainfall, 
Effective Drought Index and SPI, climate indices such as SOI and NAO indexes as input 
layer, to forecast drought.  

e) Hybrid models 

Hybrid models are used to predict with higher accuracy and lead time, a drought event 
by using the strength of individual models. If we take a wavelet transformation method, we 
can capture information for various resolution levels, but if we used these information with 
a neural network model, then we can decomposed the sub-signals from wavelets and 
reconstruct forecasted sub-signals to the original series. For example, in case of drought 
forecasting, we could use PDSI as a drought index to improve the performance of the neural 
network to create a more accurate indexed regional drought forecast.   

2.5.1 Drought forecasting system 

The advances made in the seasonal climate forecast are a promising evolution for 
the drought prediction improvement and the development of components for a global scale 
drought forecast system.  The South Asian Land Data Assimilation System (SALDAS) was 
first designed as a drought monitoring tool. In monitoring mode, SALDAS ingests gridded 
satellite-informed meteorological fields and land surface parameters and uses these data to 
drive simulations with an advanced land surface model. The system yields near real-time 
estimates of surface hydrological conditions as well as downscaled meteorological 
estimates relevant to drought monitoring. SALDAS was recently augmented with a 
seasonal forecast mode, in which meteorological fields are downscaled from the NASA 
GEOS global forecast system and are used to drive land surface model simulations as far 
as nine months into the future. This system is implemented using the NASA Land 
Information System (LIS), a software framework that allows for flexible integration of 
diverse datasets and models. As an operational monitoring and forecast system, SALDAS 
provides an improved detection of soil moisture drought, increase the reliability of 
hydrological drought forecast products, and finally, a better real-time prediction 
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information. Nowadays, the main used indices for the global system for drought detection 
are the SPI or the percentile of soil moisture/runoff.  

Nevertheless, drought tendency (e.g., onset and end, persistence etc.) still requires 
more studies. Essentially, to be able to predict more accurately drought tendency, we need 
firstly to be able to predict with better accuracy several crucial meteorological variables 
(i.e., precipitation and temperature). Statistical approaches are based on empirical 
relationships found in historical data records but they do not take into account the 
underlying physical mechanisms of drought. However, these approaches are partly useful 
due to their easy implementation technique. Additionally, drought forecasts from these 
approaches are only used as baseline or benchmark for dynamical forecasts, as well as to 
provide complementary forecast information for certain seasons or region.   

Figure 2.9 illustrates the essential elements of Land Information System (LIS) based 

drought forecast system. 

 

Figure 2.9: Components of SALDAS drought forecasting system 

3 Drought communication and dissemination systems 

Drought Early Warning Systems (EWS) are of crucial importance in drought-prone 
regions and for communities dependent on reliable water supply (especially those living in 

semi-arid areas with naturally low rainfall). DEWS can provide a set of drought related 
information advisories and information required for the selection of the most adequate 
mitigation and adaptation options to be implemented.  

Two key considerations can be identified for drought EWS development. Firstly, they 

are designed with the goal of institutionalizing the collection of data needed for drought 
indicators monitoring (i.e., monitoring of weather indicators) and used to detected, predict 
progression of drought and its impact on water and/or pasture. Secondly, DEWS offer 
information on the effects of drought, but more importantly provides the drought-prone 
communities with timely notice on the event which is primordial if we want to have an 
adequate drought response.  
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Effectiveness of a drought EWS is based on the quality of the disseminated information 
and on the use of the most appropriate communication mechanisms/channels. We measure 
the quality of an information by its level of availability, relevance, timeliness and 

accessibility. The more commonly identified, as the best, communication channels for 
information dissemination are electronics (e.g., telephones, phone text message, internet 
etc.) and printed media (e.g., bulletin), community gatherings or extension services. Still, 
to select the most suitable channel of communication a context-based approach needs to be 
adopted. For example, the effectiveness of printed media is directly affected but the low 
literacy rate of a given community, whereas electronic media effectiveness can suffer from 

a low access to electricity. Similarly, the content, format, language used in the disseminated 
information, if not user-friendly, can constitute a setback for the utilization of such 
information and diminish the effectiveness of the DEWS. Indeed, it is important to ensure 
that key messages are understood without any difficulties by the targeted communities.  

3.1 Drought Preparedness Planning (timing and methods of communication) 

Most communities manage drought on a reactive, rather than pro-active basis. 
DEWS however permit more proactive and adaptive drought management to be 
implemented. Guidelines and checklists have consequently been developed so that the 
public or private sector involved in developing a DEWS can be most effective. A 10-step 
drought planning process has been proposed by Wilhite et al. (2005), including:  

10 Steps for Drought Planning  

1. Appoint a Drought Task Force  

2. State the Purpose and Objectives of the Drought Plan  
3. Seek Stakeholder Participation and Resolve Conflict  
4. Inventory Resources and Identify Groups at Risk  
5. Develop Organizational Structure and Prepare Drought Plan  
6. Integrate Science and Policy, Close Institutional Gaps  
7. Publicize the Proposed Plan, Solicit Reaction  

8. Implement the Plan  
9. Develop Education Programs  
10. Post-Drought Evaluation  

Each step has an associated goal, with steps 1 to 4 working to ensure that appropriate 

experts and stakeholders are brought together to assess drought risks and formulate a timely 
plan. The fifth step underscores the importunate of developing an appropriate institutional 

arrangement to complete the production of an appropriate and cross-sectoral integrated 
drought management plan. In this step, it is crucial to develop a thorough vulnerability 
profile for different sectors (agriculture, industry, recreation, forestry, etc.), population 
groups, regions, and communities. The following steps focus on publicizing the plan, 
efforts to gain public acceptance and endorsement, and the need for on-going research and 
coordination between scientists and policy makers.  Finally, the 10th step emphasizes the 

importance of adaptation and consistent revision of the drought plan to keep it up to date 
with the flow of monitoring and research results.  Importantly, many of these steps can be 
implemented simultaneously and can run in parallel following task force formation. 
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3.2 Communication of drought information to farmers 

Increasing connectivity and access to Information and Communication Technologies 
(ICT) make the dissemination of information from drought prediction systems easy and 
effective. The dissemination of drought information and warnings, and more broadly of 
climate information services, has three key components. These include  

1) Data generation and knowledge production (i.e., climate data collection and 
analysis),  

2) ‘Translation’ of this information into a format that can be easily communicated and 
understood by non-scientists and non-specialists to make more informed decisions, and  

3) Use of effective strategies to increase information uptake and actual use by end-
users.  

The previous paradigm of scientific extension was linear, e.g., scientists produce 
knowledge and deliver it to end-users. Conversely, use of ICTs and the ability to crowd 
source information has resulted in the multidirectional flow of data between information 
producers, end users, and others involved in generating, using and validating climate 
information.  

As such, firstly, ICTs can be used to improve weather monitoring and validation. One of 
the main drought mitigation strategies, by providing remote sensing infrastructure and 
equipment (e.g., software and hardware, servers, databases, GIS, neural network etc.) for 
drought data analysis (e.g., statistics, modelling, mapping etc.).  

Secondly, ICTs can be an important in information dissemination strategies by offering 
a range of tools to provide end users of drought monitoring and forecasting information 
with the most relevant information (e.g., precipitation information for farmers via mobile 
phone networks, SMSs, interactive voice response systems, etc.). Television, radio and 
newspapers (including on-line sources) are the most commonly used media for transmitting 
climate and weather information to the public and decision makers. Smart phones and 
mobile networks are however skyrocketing in popularity (even in remote rural areas), and 
are a promising technology for mass dissemination of drought information. Additionally, 
the use of mobile phone for information distribution has proven in many cases to low-cost, 
accessible, and consequently efficient.  

Finally, ICT can be used to develop client-oriented and people centred drought early 
warning and information dissemination systems, that help empowering drought affected 
communities at the local level. Because ICTs are interactive, they can help foster an 
increased sense of activity and ownership by users, especially when information is crowd 
sourced. Comprehensive monitoring information and forecasts can then be delivered in 
tailor-made ways. Evidence indicates that this can increase people’s confidence in drought 
EWSs, which has positive effects in terms of facilitating informed and adaptive action to 
mitigate the harmful effects of drought. 
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Exercise 1: NDVI Calculation using MODIS (MOD09A1) Images in QGIS 

The Normalized Difference Vegetation Index (NDVI) is a versatile index to evaluate the 

vegetation and dynamic of the vegetation coverage change. This tutorial shows the way to 

calculate NDVI from multispectral satellite images using QGIS. 

The formula for NDVI calculation is: 

NDVI = (NIR - R) / (NIR + R) 

Where, NIR = Near InfraRed band and R = Red band  

Principle of NDVI: 

Reflectance is the ratio of energy that is reflected from an object to the energy incident on 

the object. Spectral reflectance of a crop differs considerably in the near infrared region (λ 

= 700-1300 nm) and in the visible red range (λ = 550-700 nm) of the electromagnetic 

spectrum. Plants generally have low reflectance in the blue and red portion of the spectrum 

because of chlorophyll absorption, with a slightly higher reflectance in the green, so plants 

appear green to our eyes. Near infrared radiant energy is strongly reflected from the plant 

surface and the amount of this reflectance is determined by the properties of the leaf tissues: 

their cellular structure and the air cell 

wall-protoplasm-chloroplast interface.  

Objectives 

 To learn NDVI calculation process 

and visualize spatial patterns of the 

index over Afghanistan and 

Pakistan. 

Datasets 

 MODIS satellite  

Software 

 QGIS 

In this tutorial, we will be using the 

MODIS Land Surface Reflectance images downloaded from 

https://earthexplorer.usgs.gov/ .You will need to have username and password for 

downloading the images.  

Spectral and Spatial MODIS Land Surface Reflectance (MOD09A1): 

MOD09A1 consists of seven spectral bands with a spatial resolution of 500 meters. Each 

product pixel contains the best possible observation during an 8-day period based on high 

observation coverage, low view angle, absence of clouds and aerosol loading.  

  

https://earthexplorer.usgs.gov/
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Table: Science data sets for MOD09A1 [1] 

Science Data Sets 

(HDF Layers (13))  
Units  Data Type  

Fill 

Value  

Valid 

Range  

Factor 

Scale 

Surface Reflectance for band 

1 (620-670 nm)  
reflectance  

16-bit signed 

integer  
-28672  

-100 - 

16000  
0.0001 

Surface Reflectance for band 

2 (841-876 nm)  
reflectance  

16-bit signed 

integer  
-28672  

-100 - 

16000  
0.0001 

Surface Reflectance for band 
3 (459-479 nm)  

reflectance  
16-bit signed 
integer  

-28672  
-100 - 
16000  

0.0001 

Surface Reflectance for band 

4 (545-565 nm)  
reflectance  

16-bit signed 

integer  
-28672  

-100 - 

16000  
0.0001 

Surface Reflectance for band 

5 (1230-1250 nm)  
reflectance  

16-bit signed 

integer  
-28672  

-100 - 

16000  
0.0001 

Surface Reflectance for band 

6 (1628-1652 nm)  
reflectance  

16-bit signed 

integer  
-28672  

-100 - 

16000  
0.0001 

Surface Reflectance for band 

7(2105-2155 nm)  
reflectance  

16-bit signed 

integer  
-28672  

-100 - 

16000  
0.0001 

Surface reflectance 500m 

quality control flags  
Bit field  

32-bit unsigned 

integer  

4294967

295  
NA  NA 

Surface reflectance day of 

year  
Julian Day  

16-bit unsigned 

integer  
65535  0 - 366  NA 

In this exercise, MODIS (MOD09A1) images downloaded on 7 March 2018 will be used. 

Band 2 and 1 represents the Near Infrared and visible red bands respectively in the images 

which will be used to calculate the NDVI in Afghanistan and Pakistan. The result will be 

compared with the NDVI calculated on 15 March 2019. 

Steps: 

 Open the QGIS Desktop software on your computer. 

 In QGIS, on manage layer Toolbars, Click on Add Raster Layer  icon to add 

Raster data 

 Now navigate to the folder D:\Drought\NDVI_calculation or where you have copied 

your data 

 Select both the images with suffix B1 and B2 (.tif)  in the file and Click open the Image,  
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 Browse through and select the satellite image from its location. The image will be 

displayed in the screen as shown in following figure. 

 

 Click Raster on the the main tool bar. From the dropdown menu, select Raster 

Calculator. 

 

 

 Then the Raster Calculator window opens up. In the leftmost section, a list of available 

bands is displayed. From the above table, band 1 and band 2 for the MODIS images 

are Red and Near Infrared bands respectively. 

 Then in the Raster calculator expression at the bottom, insert the formula for NDVI 

calculation using band 2 and band 1. *Double click raster 
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 Expression in Raster calculator for NDVI calculation  

 Select the output format to the default GeoTIFF and provide the location for the output 

layer. The default Coordinate Reference System will be that of the input satellite data. 

Click OK for calculation of NDVI. 

 

 The resulting raster will be displayed once the process is completed.  

 

 Output NDVI raster 
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 You can now render this output raster layer to any colour you like from the properties. 

 Right click on the NDVI layer and Select Properties 

 

 In style Tab, choose render type as Singleband pseudocolor as seen below, 

 In colour, Choose the desired choice of yours and click Apply 

 

Your image should look like this 
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Comparing the NDVI between 7 March 2018 and 15 March 2019 in Afghanistan and 

Pakistan  

 

NDVI in 7 March 2018 covering Afghanistan 

and Pakistan 

 

NDVI in 15 March 2019 covering 

Afghanistan and Pakistan 
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Exercise 2: Visualizing and interpreting time series data; detecting anomalies in 

NDVI data  

The NDVI is an important parameter to detect vegetation changing conditions. As we 

already saw, NDVI values changes with the increases (indicates a healthy vegetation) or 

decreases (indicates a non-healthy vegetation) in greenness. Precipitation are vital for 

vegetation growth and for the overall plant health condition. Furthermore, this also denotes 

that NDVI values are linked to precipitation fluctuation and their impacts on vegetation. 

Thus, NDVI image of a reference year can be used to evaluate the vegetation change in 

previous and upcoming years. Additionally, anomalies at different spatial and temporal 

patterns can be analysed and interpreted. 

The Software for the Processing and Interpretation of Remotely Sensed Image Time Series 

software (SPIRITS) aims to provide automated and advanced time series processing for 

very large series of images with a temporal resolution of one day, 10 days, one month or 

one year. The following exercise includes some methods for analysing time series data. 

Objectives 

 To learn how to use the SPIRITS map generator for the display of SPIRITS images. 

 To analyse the time series images and learn how to detect anomalies in crop growth. 

Datasets 

 MODIS satellite based 10-day composite of NDVI data (2007-2017) 

Software 

 SPIRITS 1.5.0 

Methodological Steps 

 Importing time series of images 

 Masking 

 Generate Map Series 

 Time series analysis across seasons 

Outputs 

 Time series map of NDVI for 2015 to 2019 

 Anomaly maps based on the comparison with historical year 

Installation of SPIRITS and getting started 

In this part, we will install the software on our computer and set-up a SPIRITS-project 

 Double click on SpiritsExtract_151 zip file and extract the files to you desired drive 

for example C:\ drive. 
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 Create a shortcut for the Spirits.jar file on the desktop. 

 To start, double-click on the SPIRITS application icon on your desktop, or double click 

on Spirits.jar in the installation folder. 

Alternatively, you can open the SPIRITS window through cmd. 

Note: In order for SPIRITS to work properly, JAVA 1.6 or higher needs to be installed 

on your computer. 

SPIRITS-Project 

When you open SPIRITS for the first time, a default project named SpiritsDefaultProject 

is created. The project refers to a directory with the same name in the installation folder: 

‘\Spirits\SpiritsDefaultProject\’. For this exercise, you will change the project name and 

project resource folders.  

Two important remarks are: 

 Be aware that you will generate lots of data in the following exercises, and that there 

needs to be sufficient (10 GB) free disk storage on the disk where you store the data. 

 SPIRITS can show errors when data are stored in a directory with a very long path. 

Therefore, consider saving the tutorial data directly on your hard disk instead of 

copying it on your desktop. 

Once you have opened the SPIRITS window: 

 Go to File> Projects> Select and specify the project directory: D: \SPIRITS\NDVI. 

Click  button to browse through your directory and press Select when finished. 

 To change the links to the different file directories, go to File> Projects> Define. 

Different types of files will be saved in different subdirectories which will make it 

easier to retrieve these files. 

In the project settings you have settings where you have specified a number of default 

paths per file type : task files (*.TNT), scenario files (*.SNS), user tool files (*.UNT), 

list of files (*.LNL), chart files (*.CNC), Map files (*.QNQ), image files (*.IMG, 

*.HDR), VAR and MTA metafiles (*.VAR, *.MTA), Rum files (*.RUM), 

Specification files (*.SPC, *.SPP, *.SPS, *.SPU, *.SPM), PNG files (*.PNG), Text 

files (*.TXT) and vector files (*.SHP). 
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 Change the link to the resource folders as shown in the screenshots above and click 

Save. 

File Naming 

The SPIRITS software works on time series of data and the DATE notification is therefore 

always an essential part of the filename. This software requires the data to be named 

[prefix][DATE][suffix].[ext.]. The structure of the filenames in the given data is 

M_YYYY_MM_DD.tif (M2015_01_01.tif).To rename these files, you have to proceed as 

follows: 

 Click File> Files> Rename. Define “D:\SPIRITS \NDVI_data” or the path where you 

have stored your data as the input directory by clicking   button and output 

directory (“D:\SPIRITS\Renamed_NDVI”).  

 Define the input name pattern as “M*_*_*.tif” (e.g. M2015_01_01.tif) and press 

Enter. Notice that the rename tool gives the variable characters a specific code: 

“M%0_%1_%2.tif”. You will use these codes in the renaming operation. 
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 Now go to the Reformat dates tab. Define Output Periodicity as “Dekad” and 

Extract as “day in month, month in year”.    

- Select Year_1950_2049 from the drop-down box as the format to be used in Year, 

Month_1_12 in month and Day_01_31 in day in year. 

- The Year is %0, month is %1 and day in month is %2. 

 Define the output date format, by choosing values for prefix (Modis), date 

(“YYYYMMDD”), which will result in a filename “ModisYYYYMMDD”. 

 Check the Preview table at the bottom, and make sure there are no warnings (in red). 

 Now click Execute and check in the directory if the renaming has worked fine. 

 To save these parameters of this rename tool as a task file (TNT), click File>Save As 

and provide file name e.g. “rename.tnt” Close the rename tool. 

  

Importing the time series 

To import time series of files and transform them into SPIRITS, a new scenario has to be 

configured in the Generic Import tool. 

 Go to Import/Export>Generic importer>Tool  

 Select list of files and create New list, and navigate to the folder 

D:\SPIRITS\Renamed_NDVI  

 Select the .tif files to be imported and add (save) to the list 

 Choose “D:\SPIRITS\Import” as Output path   
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 Make sure you select conversion datatype as “Integer 16 bit”. 

 Go to Adapt HDR tab. 

- Add description “MODIS 10 day NDVI”. 

- Scroll down to Spectral field where, Yname defines the variable name (“NDVI”). 

Yunit defines the variable unit (unitless). Vint is the intercept to convert DN 

values to real values in the equation V=Vint+Vslo*DN. Vslo is the slope 

coefficient in this equation given as Vslo=(maximum physical index specified-

minimum physical index specified)/(Vhi-Vlo) i.e. (1-(-0.2))/(250-0)=0.004. Vint 

is the intercept given as (minimum physical index specified-Vslo*Vlo) i.e. (0-

0.004*0) =0. Vlo i.e. 0 is the minimum digital value specified and Vhi i.e. 250 is 

the maximum digital value specified. 

- Define Flags as 255=black. 

 

     

 Go to Rescale tab. 

- Click on New 

- Select Integer (16 bit, signed) as input datatype and Byte (8bit, unsigned) as 

output data type. 

- Add the slices as shown in the screenshot of scaling and reclassification tab. 

- Save and close the specification 

- Execute 
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Masking 

Rasterize Shapefiles 

In this part, you will rasterize the ESRI Shapefile (SHP) containing the district of 

Afghanistan and Pakistan to an ENVI raster image file (IMG). 

 Open the <Import / Export> <Vectors><Rasterize SHP> tool. 

 As input SHP, choose the ‘‘Districts_AFGH_PK.shp’’ file from the 

‘D:\SPIRITS\VECTOR_ADMIN_Boundary. 

 Check whether the input file is recognized by the gdal_rasterize utility by clicking on 

the <Info> button. 

 Save the output IMG in the same directory, e.g. choose as output IMG filename: 

‘D:\SPIRITS\VECTOR_ADMIN_Boundary\ AFGH_PK_boundary.img 

 The framing of the output image file can be specified based on corner coordinates and 

resolution, corner coordinates and number of rows and columns, or by using another 

HDR file. In this case you will use one of the NDVI header files, so the output IMG 

from the rasterizing process will have the same framing as the NDVI images. Choose 

one of the header files in the “D:\SPIRITS\Import” as reference. 

 Specify the output parameters. Use the region ID as attribute in the output raster 

image. The Rasterized data type of the output image can thus be “Byte” (8 
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bit,unsigned) ” 

 Select one column of the SHP attribute table output attribute: <ID>, which contains an 

ID of the different regions (click on to open the attribute selection panel, select the ID 

column < ID> and click <Ok>).  

                

The header (HDR) with metadata needs to be adapted. Check the <Adapt> checkbox, and 

make sure the HDR file will contain the correct spectral information.Yname = “ID” 

 Yunit = “-“ (none); Vlo = “1” (lowest ID number); Vhi = “25” (highest ID number) 

Vint = “0” (intercept of scaling); Vslo = “1” (slope of scaling); Click <Execute> and 

follow the process in the Tasks queue. 

Mask 

 Open <Processing> <Thematic> <Simple masking> <Time Series >. 

 Create a <New> scenario for input images to be masked, and name it 

“AFGH_PA_Mask_NDVI”. 

 Select Periodicity as “Dekad” 

 Select input path directory “D:\SPIRITS\Import” , Prefix as “Modis” and date as 

“YYYYMMDD” 

 Create a new folder “Masked” in D:\SPIRITS and specify the output directory as 

“D:\SPIRITS\Masked” and use “YYYYMMDD” as date. 

 Under Mask Parameters, select AFGH_PK_boundary.img from 

“D:\SPIRITS\VECTOR_ADMIN_Boundary” as Mask image, created in Rasterize 
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Shapefiles exercise. 

 Now specify the Lower and Upper mask value. Pixels with a value in the mask image 

within this range will be flagged in the out image. Define “0” as both the lower and 

upper mask value, since this is the “no data flag” value in the regions image. 

  Specify “255” as Output flag (i.e. background). And save the scenario. 

  In the mask main window select the Start and End date and Click <execute>.  

 

    

The masked image is shown in Figure below 

 

           

(a)  
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Creating map template to visualize an image 

The map generator enables the visualization of images and vector layers and allows you to 

add a legend, title, logo, etc. 

 Open Analysis>Maps>Create Templates. 

 Go to Quick Look tab; load one of the extracted images (for eg. 

Modis_20150101.img) in the Image tab from “D:\SPIRITS\Masked”. 

 Change the image position and size so it is placed in the upper left corner (eg. 

Left=”10”, Top=”10”, Width="150", Height=”450” pixels). The value of the Width 

field will automatically be adapted to maintain the same ratio between Height and 

Width  

 Change the Border Width to “1” and Border Margin to “0”. 

 Go to Canvas tab and adjust the width and height based on the information (legend, 

title, logo, etc.) to be represented. (for eg. Canvas Width=”380” and Height=”480”) 

To change the colour scaling and legend of the image. 

 Go to Colours tab, click Auto, select Transition type “3 colour transition” and 

define From value= “0”, Reference value = “0.25”, Till value = “1” and Step value 

= “0.1”. 

 Scale the values for the From Colour, Reference Colour and Till Colour 

respectively as shown in the screenshot. 
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*Please note that legend colour can be set manually also. 

 Now go to the Legend tab and set the parameter as shown in the screenshot below: 

 

 To add a vector layer, go to Vectors tab, click Add or button to add the shapefile 

of the study area. (from “D:\SPIRITS\VECTOR_ADMIN_Boundary\ 

districts_AFGH_PK.shp”) 

 To add a title, go to Texts tab and click Add to add a new text box. 

 In the Text Box window, again click Add to add a first line. Double click on the added 

line and provide the date of the image displayed (type “Period: %35 %37and Dekad 

%39). Then apply other changes in this window as shown in the screenshot below: 
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 Click Apply and see the result. 

Note: In order to retrieve this information from the image header, click on Show/Hide  text 

Parameters. The advantage of using text parameters for the map title is that this is 

automatically updated when loading another image. 

 

 You can now save the map by clicking File>Save As. Save the file as e.g. 

“D:\SPIRITS\NDVI\Maps.qnq”. 

 You can also export the map to a PNG file (try File>Export PNG). An example of 

exported map is shown below :  
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Generate Map Series 

 Go to Analysis>Maps>Map Series>Time Series 

 Use the  button and load the Map template that you created in the previous part 

of the exercise (Browse to “D:\SPIRITS\NDVI\Maps.qnq”) 

 Select “D:\SPIRITS\Masked” as Input path and “Month” as periodicity in the drop-

down menu. 

 The file structure is “YYYYMMDD” for the input and “YYYYMMDD” for the 

output files.   

 Define “D:\SPIRITS\NDVI\Map Series” as the output directory. 

 Enter the start and end date (“20150101” and “20190510”) and press Execute. 
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This process takes some time to get completed. You can see the ongoing process at the 

right side of Spirits’ window. Once the execution gets completed, you can go to the path 

specified and inspect the generated files. The output files are in PNG format. 

Some maps for the year 2018 are given below for whole study region and the masked 

district (Paktia) of Afghanistan. 

(a) 

      

(b) 

 

          January                          April                              July 

Anomalies  

In this exercise, you will create anomaly maps based on the comparison of the NDVI data 

with the historical year. 

In the calculation of anomalies, the current month or dekad or season is compared to a 

certain reference situation. Many different anomaly algorithms exist, all optimized for 

particular indicators and environments. 

NDVI 

NDVI 
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 Absolute Differences: The absolute difference is calculated as: ADVIy,p = Xy,p – 

meanp, with y = the year, and p = the period in the year (month). 

 Standardized Differences: The standardized difference is calculated as: SDVIy,p = 

(Xy,p – meanp) / stdevp, with y = the year, and p = the period in the year (month). The 

Standardized Difference Vegetation Index is thus the difference in terms of standard 

deviations from the mean situation for that particular month ( April), and for each pixel, 

or also called the z-score. 

 Relative Differences: The relative difference is commonly used to estimate the 

anomalies of rainfall compared to the average situation, and is calculated as: RDy,p = 

(Xy,p – meanp) / meanp, with y= year, and p= period in the year). The RD is thus 

expressed in percentage difference compared to the mean situation in that period of the 

year, for each pixel of the image. 

You will now find the absolute differences as follows: 

 Go to Processing>Temporal>Anomalies>Time series.  

 Create a new difference scenario giving a new name (for e.g. ADVI_anomaly) 

 As difference operator, choose ‘AbsDif to historical average’. This calculates 

difference of current period minus historical average for that same period of the year.  

 Select the periodicity as “Dekad/Month/Year” in this case ‘year’ from the drop-down 

menu.  

 Define the input path as “D:\SPIRITS\Masked” and enter the data format as 

"YYYYMMDD”. 

 Choose “single fixed flag” in Flags. 

 The reference images for the historical year (i.e. long-term average) need to be 

calculated on the fly and therefore select “Calculate new”. The historical year can also 

be computed with a separate module and be stored on the disk. To compute them on 

the fly you need to select a start and an end date for the historical year. In this case 

select 2015 as starting year and 2018 as end year. 

 Save the output in the output path as “D:\SPIRITS\Anomaly\ADVI\Year” with date 

format as “YYYYMMDD”. 

 Set Diff. min as -1 and Max as 1. 

 Save the difference scenario. 

 Execute the difference scenario from 20150101 till 20181231. 

Note:  You can run the same process for relative difference and other anomaly 

calculation and for that you have to change the difference operator. 
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Create a template for a single image and use it to visualize the map series showing anomaly 

in NDVI pattern. Some maps showing the NDVI anomaly are shown as absolute difference 

(a) in the figures below, relative difference (b). A comparable land cover map (globcover) 

of the study region is shown in figure below (c). 

 

(a)  2015                    2016                    2017                 2018         

      

Absolute Difference 
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(b) 

    

Relative Difference 

(c) Land cover map (Globcover)  
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Exercise 3: Monitoring drought using climate variables - Average, Trend, SPI  

The Standardized Precipitation Index (SPI) developed by Thomas B. McKee is a valuable 

tool for the estimation of the intensity and duration of drought events (Mckee, Doesken, & 

Kleist, 1993). The SPI is based on the use of historical data by analysts to calculate the 

probability of a rainfall event to be equal or less than a certain average amount for a given 

period of time. Indeed, the SPI is based on the use of a cumulative probability function 

calculated from past rainfall events occurring at a station. To achieve this, the historic 

rainfall data of the station is fitted to a gamma distribution, as the gamma distribution has 

been found to fit the precipitation distribution quite well.  

Analyst can calculate the probability of a specific rainfall event and compare it to the 

cumulative probability function to identify either drought event or abnormal wetness event.  

The SPI has the following traits (Mckee et al., 1993): 

 The SPI is uniquely related to probability. 

 The precipitation used in SPI can be used to calculate the precipitation deficit for the 

current period. 

 The precipitation used in SPI can be used to calculate the current percent of average 

precipitation for time period of one months. 

 The SPI is normally distributed so it can be used to monitor wet as well as dry periods. 

 SPI is normalized so that wetter and drier climates will be represented in a similar way. 

By using the SPI as an indicator, we can formulate a functional and quantitative definition 

of drought for each time scale. A drought event for time scale (i) is defined here as a period 

in which the SPI is continuously negative and has a value of -1.0 or less. We can say that 

a drought events starts when we observe for the first time the SPI value falling below zero. 

Conversely, the end of a drought event can be identify as the first time when the SPI value 

is positive following a value of -1.0 or less.  

Drought intensity is arbitrarily defined for values of the SPI with the following categories: 

SPI Values Drought Category 

0 to -0.99 Mild drought 

-1.00 to -1.49 Moderate drought 

-1.50 to -1.99 Severe drought 

<= -2.00 Extreme drought 

 

Software: 

The GeoCLIM (https://chc.ucsb.edu/tools/geoclim) is a specific software designed for 

climatological analysis of historical rainfall, evapotranspiration and temperature data. With 

the support from the USAID preparedness and Global Climate Change activities, the 

https://chc.ucsb.edu/tools/geoclim
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software was developed by Tamuka Magadizire of USGS FEWS NET. Furthermore, the 

GeoCLIM provides a range of easy to use analysis tools for climate-smart agriculture 

development. These user-friendly tools can be used to: 

 Blend station information with satellite data to create improved datasets, 

 Analyze seasonal trends and/or historical climate data, 

 Analyze drought for a selected region by calculating the standardized precipitation 

index (SPI), 

 Create visual representations of climate data, create scripts (batch files) to quickly and 

efficiently analyse large quantities of climate data, 

 View and/or edit shapefiles and raster files, and extract statistics from raster datasets 

to create time series. 

Hands on Exercise: SPI computation using GeoCLIM 

Objectives 

 To analyse the satellite derived rainfall product  

 To calculate SPI for assessing the drought severity 

Dataset Used 

 CHIRPS 

Software 

 GeoCLIM 1.2.0 

Step 1: Software Installation and Settings 

System Requirements 

1. Microsoft Windows Operating System (XP or later) 

Downloading and Installing the GeoCLIM 

The latest version of the GeoCLIM can be downloaded from: 

https://chc.ucsb.edu/tools/geoclim or http://earlywarning.usgs.gov/fews/software-tools/20  

First Time Users: 

 Download the latest GeoCLIM version from above mentioned address. 

 Open the file and follow the instructions for default installation. 

 Then run the program by going to the Start Menu. 

  

https://chc.ucsb.edu/tools/geoclim
http://earlywarning.usgs.gov/fews/software-tools/20
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Step 2: Select Geographic Area and Region 

The GeoCLIM works on particular geographic regions. The different regions are provided 

as part of the program and the users also have the option to create their own.  

 For selecting the existing regions, open the program.  

 Once the program opens, choose a geographic area from the ‘Select a Geographic 

Area’ menu and a region or specific country from the ‘Select Region’ menu. 

 

Select Region of interest. If not available, select one of the available regions  

and add new one later 

Step 3: Select the working directory 

 Select the directory where you want to locate the default GeoCLIM workspace 

directory for all the related files, data and outputs. The default workspace will be 

C:\Documents. 

 

Workspace setting 

 The workspace directory can also be updated later on from a workspace setting menu. 
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  Menu option for workspace setting 

Step 4: Download or Import Data 

 A  “GeoCLIM has no data” dialogue box will appear. User can either import existing 

archives by clicking Import, download pre-existing GeoCLIM data by clicking 

Download or cancel to load data later on. 

 

Data import of download option 

 For our exercise, you will be working on a data provided. So, click cancel to import 

data later on. 

About Data 

You will be working on a satellite derived rainfall data a raster file called Climate Hazard 

InfraRed Precipitation with Station. The detail information about the data is presented 

in the following Table: 

File Name CHIRPS_PPT_GLOBAL_monthly.climdata 

Spatial Coverage Global 

Temporal Resolution Monthly, 1981-2018 

Spatial Resolution 0.05° 
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 The raster data is in compressed file format called climdata compatible for GeoCLIM 

tools. The BIL raster files will be extracted by the GeoCLIM after data import. You 

can also download the data from Climate Hazard Group website or FEWS NET 

website:  

ftp://chg-

ftpout.geog.ucsb.edu/pub/org/chg/products/GeoCLIM/Geoclim_archives/https://early

warning.usgs.gov/fews/datadownloads/Global/CHIRPS%202.0  

Import GeoCLIM Climate Archives 

A GeoCLIM archive is a compressed file containing data for a given climate variable and 

specific information so that it could be imported into the GeoCLIM. The Import Climate 

Archives tool is used to make datasets available in GeoCLIM for analysis. 

 From the main menu bar click the Import Climate Archive menu. 

 Then browse through the location where you have placed the data. 

 Select the climdata archive. 

 Then click import. 

 Then select make it a default dataset after a window pop ups asking.  

 

 

 

                            Browsing the location of data 

ftp://chg-ftpout.geog.ucsb.edu/pub/org/chg/products/GeoCLIM/Geoclim_archives/
ftp://chg-ftpout.geog.ucsb.edu/pub/org/chg/products/GeoCLIM/Geoclim_archives/
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Creating a mask  

 You should define a specific mask for the selected region for computation and display. 

 Click the Setup menu in the menu bar. 

 Select the mask tab. 

 There you will be presented two options. Select the Import Mask from Vector option. 

 Then import the vector shapefile of the study area you’re interested in. In this case 

let’s import shapefile of boundary of Afghanistan and Pakistan. 

 Define the output location of the mask file. This mask file will be in BIL raster format. 

 Select the option Outside the Map Polygons. This will assign ‘0’ value for outside 

the region of interest and a ‘1’ for the area within the region. 

 

 

 

                                       Creating a Mask 
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           Importing vector file to create raster mask file 

Defining a new region 

 You have now a mask file for your study area. 

 There are two ways to create a user-defined region in the GeoCLIM program. The first 

way is to go to File>New>Region and fill out all the fields. The other way is to modify 

an existing region from File>Edit>Region. 

 Open a New by clicking File menu item. 

 

Creating a new region 
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 Then Edit Region window opens. You have to fill all the fields in this window to 

create a new region. 

 

                                       Edit Region window 

 Import the extent of the region from the shapefile or mask file of the region. 

 The fields Height of pixel and Width of pixel refer to the pixel size that will be used 

in analysing the data – ideally this should match the pixel size of the source climate 

data. So, enter 0.05 in both these fields. 

 Specify the path of worldmask1deg.bil file as Default Mask File.  

 Then specify a shapefile for the new region in the Default Map File field. Click the 

Define button shown in the above Figure. This map is used as outline when displaying 

the results. 

 Select the mask file created in section 3.4 in the mask field. 

 Then click save and the window will automatically close. 

GeoCLIM setup 

 The user can change settings such as the region of work or the selected climate datasets 

by clicking  icon from the GeoCLIM toolbar. 

 Select the Region of interest. Select the region created in the above step. 

 The Mask tab allows the user to select a new mask or edit an existing one. The default 

mask here will be the one defined in your selected region.  

 The Data tab facilitates the selection of available datasets (rainfall, temperature and 

evapotranspiration) for analysis. The Data tab also allows the user to add new or edit 

existing climate datasets. 
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                      Region of interest selection 

 

           Selection of Mask in GeoCLIM setup 

 

                                         Data selection 
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 Your mask for Afghanistan and Pakistan should look like as shown in the figure 

below. 

 

 The View Available Data tool shows a list of the data available for analysis based on 

the climatic data selection and the region of interest. It also checks whether the selected 

datasets cover the region of interest or not. 

 The List Missing Data button provides a list of the missing files in the time series 

between the first and last date of available data. 

 

 

             List of Available Data tool for checking the datasets 
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Climatological Analysis 

The Climatological Analysis of Climatic Variables tool is used for analysing and 

visualisation of statistical characteristics of rainfall, evapotranspiration, and temperature 

data based on the time series of the data. The tool displays all the years and periods 

(months, dekads or pentads) available for a selected climate dataset. Here the user may 

select a period or a group of periods (i.e. Dekads/Months/Pentads) and years to analyse. 

Furthermore, the user can choose one of the available analysis methods such as Average, 

Trend, SPI and others.  

SPI Method:  

 Open a Climatological Analysis tool in the main toolbar or from the main GeoCLIM 

tool bar. 

 Make sure that the region of interest is selected from the Region dropdown list as 

shown in figure below. The default region selected here will be the region set up during 

first-time run. 

 You’ll be calculating SPI from the CHIRPS rainfall product. So, select the rainfall 

as parameter to analyse and SPI as the analysis method. 

 Select the periods comprising a season of interest on the left panel. The data period 

(pentads, dekads or months) is based on the selected climate dataset, Months in our 

case. So, select the month January, February and March for the analysis. 

 Select “Select all the years” on the right panel. These years will be used to calculate 

the long term mean and express the selected year as anomaly from this mean (i.e. a 

normalized variable that conveys the probabilistic significance of the 

observed/estimated rainfall). Select the year 2016 as the SPI year. 

 Check the box Add up seasonal total to calculate the total of the selected season for 

each year and July to June sequence if the season goes from one year to another. 

 Then specify the folder for the output results and click analyse. 

 

Climatological Analysis Tool 
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SPI calculation in Climatological Analysis tool for the January, February and March 2016 

 

Output SPI map for the January, February and March 2016 with the color index displayed in 

the Spatial Viewer 
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Output SPI map for the January, February and March 2017 with the color index displayed in 

the Spatial Viewer 

 

Output SPI map for the January, February and March 2018 with the color index displayed in 

the Spatial Viewer 
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 For drought analysis, a SPI less than -1.0 indicates that the observation is termed as 

”moderate”. A SPI less than -1.5 is termed as “severe”. Values less than -2.0 are 

typically referred to as “extreme” drought event. And the SPI is unitless as it is only 

the number of standard deviations from the historical mean precipitation for that 

particular period. 

Average Method 

 The Average analysis method calculates the statistical average value for each pixel for 

the season or group of periods using all the years selected. 

 Select the analysis method as average in the dropdown option. 

 Select the Month of July. 

 The seasonal total for all the selected years will be averaged out to produce average 

output map. Select all the years to analyse. Check the box Add up seasonal totals 

here too. 

 

Average rainfall calculation for the July for the years 1981-2018 
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A output average rainfall map for the July (1981-2018) (unit being mm of precipitation) 

Standard Deviation (SD) and Coefficient of Variation (CV) Method 

 These are the methods for estimating variability. The standard deviation shows the 

variability within the time series while the coefficient of variation shows the SD as 

percent of average facilitating the comparison of variability among regions. 

 SD is a measure of how spread the data are from the mean. In doing analysis based on 

the average, it is important to include the SD to indicate how much the values could go 

above or below the mean. 

 CV allows for the comparison among different magnitudes of variation or between 

regions with different means. 

 Select both analysis methods each at a time and perform analysis. 
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SD map showing variation in mm 

 

Coefficient of variation (CV) map showing the standard deviation (SD) as 

percent of the average 

Count Method 

 The Count Method in Climatological analysis tool gives the number of times a pixel 

in the time series with value different than the missing value (-9999) i.e. valid non-

missing numbers. 

 Select Count Method and click analyse.  
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Map showing count for valid non-missing values (no missing data in this case i.e.35) 

Frequency Method 

 The Frequency analysis method in the Climatological analysis tool calculates the 

number of times a range of values has occurred in the time series. 

 This method helps us to answer to questions such as “How many times has the total 

seasonal rainfall been less than 100m?” as in figure below. 

 

Frequency method for calculation of number of times seasonal total in the range 0 to 100 
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Map showing the number of times the range of 0 to 100 mm rainfall took place during the 

time series. 

Extracting Raster Statistics and Time Series 

The Extract Grid Statistics tool calculates summary statistics for a polygon or a set of 

polygons from a shapefile (SHP) file over a raster dataset or a group of rasters. These 

statistics can be used to study the trend over the time period for a particular place. 

 Open Extract Raster Statistics tool from the menu bar. 

 Select a shapefile containing polygon of interest (e.g. districts). 

 Select the type of summary ‘average’ for the pixels within the polygon in the 

Summary pulldown menu. 

 There are two ways to add the data using T-series and using Add button to select the 

raster datasets in BIL format. The T-series button allows the generation of a list of 

raster files to extract based on a time series. The Add button allows the adding of 

individual files. 

 Select T-series which opens up a new window. Click the “Use GeoCLIM Data” at 

the top right corner. This will load the default climate data in the GeoCLIM, Monthly 

CHIRPS in our case. 

 Select the month of start of the season if the computation is on seasonal basis. But now 

we only want to extract the statistics for the first July for all the years. 

 Click the Analyze button and close the window. This create a list file of the data which 

will be loaded as the raster files in the main window of the tool. 

 Specify the output file for the statistics and click ok. The output file will be exported 

as a .CSV file. 
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Exercise 4: Validation of satellite-based rainfall data against rain gauge station data  

Introduction  

For the assessment and monitoring of meteorological and agricultural drought, 

precipitation data is widely used. However, the availability of rainfall data in appropriate 

temporal and spatial scale is often limited due to data collection being mainly based on 

ground observation. Furthermore, in developing countries such as Nepal, the number of 

rain gauge stations is low and in many cases continuous short temporal data for long term 

period is missing. Fortunately, in the last few decades, advances in remote sensing have 

made it possible to acquire the rainfall data from space. If the spatial and temporal 

resolution of such data is adequate, then, this data can be a useful input for drought 

assessment and monitoring, thanks to a continuous source of data generation. But, prior to 

the use of this type of data, ones must assess the accuracy of the used satellite to read the 

rainfall events occurring on the ground. To measure the satellite-based data accuracy, 

several statistical validation techniques are used. The predominant one relies on the 

comparisons of satellite-based rainfall data against the data from the ground-based station. 

In this exercise, we will learn how to measure the accuracy of satellite-based rainfall data. 

However before doing so, we will first discuss about the data we will use, the measurement 

techniques and the requirements of software to apply those validation techniques.  

Objective 

 To learn how to validate satellite-based rainfall data against rain gauge station data  

Datasets 

 Gridded rainfall data products and stations observed rainfall data 

Software 

 MS Excel, QGIS 

Datasets 

Three rainfall datasets will be 

used for this exercise: one 

station-based dataset and two 

satellite-based datasets. All the 

rainfall data was collected for 

the period of 1983 to 2012. 

Station-based data 

Station-based rainfall data was 

collected from Department of 

Hydrology and Meteorology 

(DHM). In total, 15 stations have been selected for this exercise (see map above). Station 
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with no continuous observed data were not considered for the exercise.  For this exercise 

the data has been stored in D:\Drought\Chirp_validation_exercise\DHM folder.  

Satellite-based data 

Nowadays, a number of satellite-based rainfall data products are globally available. During 

this exercise we are going to focus on two products: a) the Climate Hazards Group InfraRed 

Precipitation (CHIRP) and (b) the CHIRP blended with ground-based station data 

(CHIRPS). Both data products have relatively high-resolution (0.05° grid) and both are 

maintained and distributed by the Climate Hazards Group (CHG) which archives the data 

products from 1981 to the near-present. Data is available at different temporal scales, e.g., 

daily, pentad (5 days), dekadal (10 days), monthly and so on. For the purpose of our 

exercise we are going to use the monthly data. While the CHIRPS product can be 

considered as more advanced and sophisticated one, the CHIRP product data are more 

immediately available. Indeed CHIRPS data are usually available with some delay. If you 

want to learn about these products you can visit the CHG website. 

(https://chc.ucsb.edu/data).  

The data for this exercise has been downloaded from CHG website and has been stored in 

D:\Drought\Chirp_validation_exercise\CHIRP and 

D:\Drought\Chirp_validation_exercise\CHIRPS. 

The validation techniques 

We will use three types of validation techniques to compare the satellite data against the 

rain gauge station data. They are as follow: 

 Regression analysis 

 Percentage Bias (PBIAS) 

 Root Mean Square Error normalized by Standard Deviation (RSR)  

By applying the above techniques we will see how two similar data fit well with each other, 

by describing their goodness of fit statistics. The fitness in regression analysis will be 

evaluated in terms of Coefficient of Determination (R2) value. Although there is no set rule 

to measure the goodness of fit with any particular value of R2, many studies shows that a 

value of R2>0.5 is good enough to compare climate data. The other two techniques, PBIAS 

and RSR, can be shown by the following equations:  

𝑃𝐵𝐼𝐴𝑆 =
∑(𝑅𝑔𝑎𝑢𝑔𝑒 − 𝑅𝑠𝑎𝑡𝑒𝑙𝑙𝑖𝑡𝑒)

∑(𝑅𝑔𝑎𝑢𝑔𝑒)
× 100 

𝑅𝑆𝑅 =
∑(𝑅𝑔𝑎𝑢𝑔𝑒 − 𝑅𝑠𝑎𝑡𝑒𝑙𝑙𝑖𝑡𝑒)2

∑(𝑅𝑔𝑎𝑢𝑔𝑒 − 𝑅𝑔𝑎𝑢𝑔𝑒
̅̅ ̅̅ ̅̅ ̅̅ ̅)2

  

Where, 𝑅𝑠𝑎𝑡𝑒𝑙𝑙𝑖𝑡𝑒 is the rainfall estimates from the CHG product; 𝑅𝑔𝑎𝑢𝑔𝑒 is the rainfall 

recorded in a particular rain gauge and 𝑅𝑔𝑎𝑢𝑔𝑒
̅̅ ̅̅ ̅̅ ̅̅ ̅ is the average gauge reading over the 

considered time span.  

How good the particular values of PBIAS and RSR can be rated by different qualitative 

https://chc.ucsb.edu/data
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performance based on several ranges of values (see table-1).  

Performance rating  PBIAS (%) RSR (-) 

Very Good  < ± 15 0 - 0.5  

Good  ±15 - ±30  0.5 – 0.6  

Satisfactory ±30 - ±55 0.6 – 0.7  

Unsatisfactory  ±55 >0.7  

Table 1: Ranges of adopted values of the Percentage of Bias (PBIAS) and Root Mean 

Squared Error normalized by Standard Deviation (RSR) for a particular qualitative rating 

(Moriasi et al. (2007) & Shrestha et al. (2017)).  

The files 

Datasets  File format  Directory  

DHM station  Esri Shapefile  D:\Drought\Chirp_validation_exercise\DHM 

DHM Precipitation  Excel  D:\Drought\Chirp_validation_exercise\Validation  

CHIRP TIFF D:\Drought\Chirp_validation_exercise\CHIRP 

CHIRPS TIFF D:\Drought\Chirp_validation_exercise\CHIRPS 

Step 1: Extracting satellite data against ground-based station data  

For validation purposes, satellite data need to be extracted against the ground-based station 

location. To do this work we will extract the rainfall estimates over the pixels of satellite 

images in which the rain gauge stations are located. Let’s follow these –  

 Open the QGIS Desktop (it is assumed that you have installed QGIS correctly and the 

Layer Panel and other visual interface of the software is organized in standard way). 

To extract the values from 

satellite images against station 

points we need “Point 

Sampling Tool”. The tool is 

not automatically available in 

the software. We need to plug 

in it from the Plugins 

repository. Follow this –  

 Click Plugins Tab, go Manage 

and Install Plugins.  

 Search Point sampling tool  

 Click Install Plugin.  

Now, the Point sampling tool has been installed and available under Plugins>Analyses 
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 Click Add Vector Layer    

 Browse the dataset to D:\Drought\Chirp_validation_exercise\DHM and select 

DHMStation.shp and open it.  

 Click Add Raster Layer  

 Browse D:\Drought\Chirp_validation_exercise\CHIRP; select all (.tiff) and open. 

It may take time to open all the data sets considering the configuration of the users’ 

systems.  

 Go Plugins>Analyses>Point sampling tool.  

 Confirm DHMStation under Layer containing sampling points.  

 Select DHMStaion: OBJECTID, DHMStation: Name and all the Raster bands under 

“Layers with fields/bands to get values from:”. Use CONTROL and SHIFT keys to 

select quickly.  

 Select the output point vector layer as 

D:\Drought\Chirp_validation_exercise\Shape  

 Name it CHIRP_valid and save.  

 Press OK.  

 After the processing is complete, close Point sampling tool.   

 

 The CHIRP_Valid shape file is at Layers Panel. Select and right click it. The 
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program can show “Bad Allocation” signal. This can happen for dealing with big 

data sets. Don’t worry. In that case close the QGIS and open it again. Add the 

CHIRP_Valid layer from 

D:\Drought\Chirp_validation_exercise\Validation\Shape. 

 After right click go to ‘Open Attribute Table’.  

This is the time series rainfall estimates of satellite images against the rain gauge station 

location. Data is extracted in the table under the particular monthly column, where, 

columns are written as “YYYY.MM”. For example, “1983.01” means the total rainfall of 

January, 1983.    

 Press CONTROL+A to select all the attributes.  

 Copy all 

 

 Now, open an excel file, save as CHIRP_Valid at 

D:\Drought\Chirp_validation_exercise\Validation folder location.  

 Paste all the copied data from QGIS attribute table to this excel file.  

 Select data under ‘Name’ column and all the monthly columns. 

 Copy the selected data  

 Open a new sheet in the excel file.  

 Past special > Transpose (T).  

 Rename Name of first cell to Date.  

 Organize the first column at Ascending order (A to Z).  

Now, time series CHIRP data against stations’ locations is ready. Do similar exercise for 

extracting CHIRPS data.  
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Step 2: Validating satellite data  

Now, we have three excel files in D:\Drought\Chirp_validation_exercise\Validation 

folder – a) DHM Precipitation; b)CHIRP_Valid; and c) CHIRPS_Valid.  

 Open the DHM Precipitation file  

The excel file has two sheets, named: All_Monthly and Dummy.  

 The All_Monthly sheet contains the monthly rainfall from January 1983 to December 

2012. The format of date is “MM/YYYY”. For example, 01/1983 means January 1983.  

 The Dummy sheet is basically an Excel style sheet to calculate all the validations. 

Here, the validation equations were designed according to the discussions in the 

validation techniques section. Using this style sheet we can perform the same 

validation techniques against all the gound-based stations individually. All we will 

need to do is to copy the data in the Dummy sheet and get the result.  

Perform validation 

 Right click on the name of Dummy at the bottom.  

 Select Move or Copy>Dummy, check on ‘create a copy’ box, and click ok.  

 

 

 

 

 

 

 

 

 

 

 

 

 Rename the new sheet as Khumaltar.  

 Click or open the All_monthly sheet.  

 Click on ‘Name’ or top most corner cell.  

 Click on Sort & Filter tool ; click filter.  

 Click the filter button on station name and select only Khumaltar.  

 Copy the data under RainGauge column.  

 Open the Khumaltar sheet and paste the data under Raingauge column using Past 
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Special tool and paste only values. Before doing this step make sure that date columns 

in All_monthly sheet and Khumaltar sheet are ascended in same order starting from 

01/1983.  

 Minimize the DHM Precipitation file.  

 Open CHIRP_Valid excel file and copy the time series rainfall data till 12/2012 under 

Khumaltar.  

 Go to DHM Precipitation file again and click Khumaltar sheet.  

 Paste the copied CHIRP data using Paste special and paste only values under CHIRP 

column.  

 Similarly, follow last three steps to copy and paste CHIRPS data.   

 Double click one regression curve; go to QuickLayout and selct Layout 9.  

 Do the same thing for another curve.  

Results 

Now, we have gotten all the validation results. The results are as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

Here we can see that the result for CHIRPS is 0.85. This means that the CHIRPS fits better 

for Khumaltar station.  

PBIAS_CHIRP PBIAS_CHIRPS RSR_CHIRP RSR_CHIRPS 

-10.2020266 1.189243861 0.5477677 0.3874671 

The PBIAS is very good for both CHIRP and CHIRPS; and the RSR is also very good for 

both cases according to the performance rating that we discussed in table 1. 

We can apply similar steps for other stations using the same Excel stylish sheet (dummy 

sheet) to verify the satellite data has acceptable accuracy against the ground-based data.  
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Using the GeoCLIM  for Validation of Satellite Rainfall 

The Validate Satellite Rainfall option allows for the evaluation of grid/raster datasets (e.g., 

satellite-based rainfall estimates) using discrete points in space (e.g., rain gages). The 

validation helps to determine if the two datasets are correlated to help in deciding if the 

blending option can be used with the two datasets. The first step of this process is to extract 

values from a raster/grid at all locations where the point data have valid values (i.e. non-

missing values. Missing values can be specified in the inputs). The result is a dataset of 

grid values that can be directly compared to the point values. Another result is a diagnostic 

file with information of the least-squares regression between the observed/in-situ data 

value at the points being evaluated and the extracted grid values along with a R-squared 

output value. Once the correlation has been determined, then the raster and station data can 

be blended into an improved dataset. 

To use this option, follow the three steps below: 

Step 1: Select BASIICS option. 

1. Click on the BASIICS icon from 

the GeoCLIM main toolbar to open the 

Batch Assistant dialog box (Step 1). 

2. Select the ■ Validate Satellite 

Rainfall option. 

3. Click on the > Next button to 

proceed to Step 2.  

 

 

 

 

 

Step 2: Select the validation time interval 

and period. 

4. Select the time interval (e.g. month, 

dekad or pentads) and period (e.g. 

042013 to 052013) of the rainfall 

estimate to validate. The time period and 

time interval are based on the selected 

climate dataset definition. In this 

example we are using monthly data. 

5. Click on the > Next  button to proceed to 

Step 3. 

Step 3: This Step has three sections 

Step 2 requires specifying of  the period and Time 

Interval of the data to be analyzed. 

There are three Batch Assistant options available; (1)Blend 

stations and raster data, (2) Validate Satellite Rainfall and 

(3) Interpolate Just Stations. 
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Section 1: Grid 

This section relates to the raster/grid input parameters. GeoCLIM only allows validation 

of climate datasets that have already been registered in GeoCLIM. To select the climate 

dataset to be validated, use the GeoCLIM dataset ˅ pull down menu then click on the 

GeoCLIM button to automatically populate all the fields in this section with the 

information of the selected dataset.  

Section 2: Stations 

This section relates to the station input parameters. 

6. Check □The station data is all in one file box, then select the file which contains the 

station data. The file must be in CSV format, see an example on Figure below. See the 

Data Types chapter for more information on the format of the table and other file types 

in GeoCLIM. If the station data are in separate files, leave this box unchecked. 

7. After selecting the stations file(s), the Define Delimited Data Text File dialog box will 

open showing the format of the station file: the header row (usually row 1), the first 

row that contains actual data (usually row 2), and the delimiter (usually comma). Make 

To validate raster data using station values, it is required to specify the 

path to the raster data and a table with the station values. 

Section 1 

Section 2 

Section 3 
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any necessary changes for the correct specifications. Click OK when all the 

specifications are defined.  

Next, make sure that the columns with Station ID, Latitude, Longitude, Year Info, and 

the first and last period (the period could be pentad, dekad, or month), and the missing 

value have all been specified.  

Section 3: Outputs 

8. Specify the file location where the statistical outputs will be written.  

9. Click on Finish. 

10. A batch file is generated and displayed on the GeoCLIM Batch Text Editor. The 

information displayed comes from the inputs entered on the three previous steps. This 

batch file can be saved for future reference or edited to run a new process.  

11. Go to the Run pulldown menu and select Run Batch File  to start the validation. 

Alternatively, press the F5 key on the keyboard. 

 

Once the validation process is completed, it creates the following four outputs:  

12. A graphic map in PNG format showing the stations used for validation overlaid over 

the time-corresponding rainfall field. 

13. A scatterplot showing the satellite rainfall field values against the station values  

14. A CSV file with columns containing the station values, the raster values for the points 

The batch file is a text file with a list of all the inputs from the three steps of 

the BASIICS validation form. 
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where the stations fall, and the at-station interpolated observed data. These at-station 

interpolated vales are produced to improve comparability between the gridded/raster 

data and the station data. The CSV file includes some statistics showing correlation of 

the rainfall field and station data.  

15. A shapefile containing all the stations that were used in the process.  

16. These outputs provide the basis to decide if it is appropriate to blend the stations and 

the raster datasets.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

A map of the stations that were used in the process of 

validating CHIRP.   

 

Scatterplot of station value on X and raster 

(CHIRP) value on Y. 

Text file that includes a list of the station value and its 

corresponding raster value for each date together with statistics 

describing their relationship. 
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Exercise 5: Background-Assisted Station Interpolation for Improved Climate 

Surfaces (BASIICS). 

Satellite data are a valuable source of 

information on rainfall, evapotranspiration, or 

temperature patterns. However, they can 

contain biases and inaccuracies due to incorrect 

or limited ground data used during calibration 

processes. Some raster data can also present a 

low resolution which means the size of the pixel 

is too large for the area of interest. To improve 

the satellite data accuracy, we can combine 

them with ground station information. 

Objectives 

 To learn how to use Background-Assisted 

Station Interpolation for Improved Climate 

Surfaces (BASIICS) tool in GeoCLIM for 

improving the results. 

Datasets 

 Two different datasets are used: (1) a point 

dataset with values at discrete points in 

space (rain gages) and (2) a grid/raster dataset with values varying continuously over 

space (satellite-based rainfall). 

Software 

 BASIICS tool GeoCLIM 

The Background-Assisted Station Interpolation for Improved Climate Surfaces 

(BASIICS) tool in GeoCLIM blends raster/grids datasets with point datasets like station 

data. The bleeding of data is achieved by using a modified Inverse Distance Weighting 

(IDW) approach, which borrows some concepts from simple kriging and ordinary kriging.  

Improve raster with stations using the blending algorithm 

 Click on the BASIICS button on the toolbar. 

 This will open up the Step 1 window. Then select the Blend raster/grids with stations 

batch operation and click on the Next button. 
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   Select the Blend raster with stations 

 Then select the Time Interval and the periods to be improved making sure that there 

are stations available for the same period to be improved. Click Next to continue. 
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 Select the starting and ending dates that would be the part of the process 

 Now a full window of Background Assisted Station Interpolation opens up. To use 

the default climate dataset, simply click on the GeoCLIM button to retrieve 

automatically all the parameters needed for the process. The missing value must be 

manually typed. 

 Then specify the file containing the station data (a CSV file), the missing value in the 

rain gauge data and the column numbers for each of the required input information 

(Station ID, latitude, longitude, etc.).  

 Specify where the outputs should go and what format they should be in. Select the 

Output Diagnostic Statistics for generating the statistics of the blending process for 

evaluating the operation performed. 

 Check the Advanced Options checkbox which will open a set of options to the right 

of the window. The upper section describes parameters for the blending algorithm. The 

first step in the algorithm is to extract values from the grid at all locations where the 

point data have valid values. This produces a comparable datasets of grid values that 

can be directly compared to the point values. As an option, the user can instruct the 

program to carry out a least squares regression between the collocated point and 

extracted grid values and output the r2 value in a statistical diagnostic file. This allows 

the user to determine whether the relationship between the grid and the point dataset is 

worth using to interpolate the data. 

 In the Define Map Limits option, import the spatial extent from a pre-existing 

GeoCLIM region Bangladesh. Define pixel size to 0.05 degrees, set the Interpolation 

style to Simple, Weight power 2, Min stations 0, Search Radius 500, fuzz factor 1, 

Max Effective distance 100, long range value 1 and Max ratio to 3. 

 Click finish, then the GeoCLIM batch text editor opens up displaying the batch file 

of just created BASIICS settings. Click Run from the menu bar to run the blending 

operation. 
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 Step 3 requires information about the raster data to be improved, the stations with 

station metadata and rainfall values 

 

 Setting Dataset name, type and spatial extent (making the dataset default in GeoCLIM) 
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 Batch Text Editor for running the batch file. 

 The output of BASIICS consists of blended BIL raster file for each individual 

dataset dekadal in our case, a CSV file of statistical diagnostic, image showing 

comparison between station and grid and cross validation between BASIICS 

interpolated value and cross validated BASIICS value. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Output of Blending process showing comparison between station and grid value 
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 Cross validation between BASIICS interpolated value and cross validated BASIICS 

value. 
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About ICIMOD 

The International Centre for Integrated Mountain Development (ICIMOD) is a regional 

knowledge development and learning centre serving the eight regional member countries of the Hindu 

Kush Himalaya (HKH) – Afghanistan, Bangladesh, Bhutan, China, India, Myanmar, Nepal, and 

Pakistan– based in Kathmandu, Nepal. Globalization and climate change have an increasing influence on 

the stability of fragile mountain ecosystems and the livelihoods of mountain people. ICIMOD aims to 

assist mountain people to understand these changes, adapt to them, and make the most of new 

opportunities, while addressing upstream and downstream issues. ICIMOD supports regional 

transboundary programmes through partnerships with regional partner institutions, facilitates the 

exchange of experiences, and serves as a regional knowledge hub. We strengthen networking among 

regional and global centres of excellence. Overall, we are working to develop economically and 

environmentally-sound mountain ecosystems to improve the living standards of mountain populations 

and to sustain vital ecosystem services for the billions of people living downstream – now and in the 

future. 

About SAC 

The Heads of the States or governments established the South Asian Association for Regional 

Cooperation (SAARC) on the 8th day of December 1985. Seven south Asian Nations, namely 

Bangladesh, Bhutan, India, The Maldives, Nepal, Pakistan and Sri Lanka were the founder members of 

the Regional Association. Later Afghanistan became the eighth member country in 2007. SAARC 

Agriculture Centre (renamed in April 2007 from SAARC Agricultural Information Centre, SAIC) is the 

first regional Centre established by the SAARC. The Centre started functioning in 1988 with a mandate 

for information management, primarily in the field of agriculture and allied discipline.With the passage 

of time, the Centre braced up broader challenges to make regional cooperation more responsive to the 

needs of the stakeholders and farming communities as South Asia heads for a new order of agricultural 

transformation. The SAARC Agriculture Centre thus has been given an enhanced mandate for 

agricultural research and development, policy planning, and knowledge management. 

About SERVIR 

SERVIR connects space to village by helping developing countries use satellite data to address 

challenges in food security, water resources, weather and climate, land use, and natural disasters. A 

partnership of NASA, USAID, and leading technical organizations, SERVIR develops innovative 

solutions to improve livelihoods and foster self-reliance in Asia, Africa, and the Americas. SERVIR 

Hindu Kush Himalaya (SERVIR-HKH) is implemented by ICIMOD in its regional member countries, 

prioritizing activities in Afghanistan, Bangladesh, Myanmar, Nepal, and Pakistan. 

About CSRD 

Climate Services for Resilient Development (CSRD) is a global partnership that connects 

climate and environmental science with data streams to generate decision support tools and training for 

decision-makers in developing countries. Translating complex climate information into easy to 

understand actionable formats to spread awareness in the form of climate services is core to CSRD’s 

mission. The CSRD consortium in South Asia is supported by USAID and led by the CIMMYT in 

partnership with the Bangladesh Meteorological Department (BMD), Bangladesh Department of 

Agricultural Extension (DAE), Bangladesh Agricultural Research Council (BARC), Bangladesh 

Agricultural Research Institute (BARI), ICIMOD, the University of Reading (UoR) International Institute 

for Climate and Society (IRI), and the University de Passo Fundo (UPF). This consortium provides 

strength and technical expertise to develop relevant climate products that can assist farmers and other 

stakeholders with relevant information to improve decision making, with the ultimate goal of increasing 

resilience to climate-related risks. 
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About CIMMYT 

CIMMYT - the International Maize and Wheat Improvement Center - is the global leader on 

publicly-funded maize and wheat research and related farming systems. Headquartered near Mexico City, 

CIMMYT works with hundreds of partners throughout the developing world to sustainably increase the 

productivity of maize and wheat cropping systems, thus improving global food security and reducing 

poverty. CIMMYT is a member of the CGIAR Consortium and leads the CGIAR Research Programs on 

Maize and Wheat. The Center receives support from national governments, foundations, development 

banks and other public and private agencies. 
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